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1. Introduction 
RangeNav™ is a transportable acoustic tracking range. It is designed to track pinger equipped 
targets for applications including underwater vehicle performance evaluations and monitoring of 
underwater assets in naval exercises. Characteristics include: 

● A compact, transportable design suitable for quick deployment and recovery at any 
desired test site. 

● Specifically optimized for littoral waters, and capable of operating at depth ranges from 
1m to 300m. 

● Designed for coverage up to 20 nautical miles x 20 nautical miles. 
● Automated acoustic self-survey determines relative station locations within minutes. 
● Simultaneous tracking of up to eight targets in three dimensions with horizontal accuracy 

of approx. 1 meter and vertical accuracy of approx. 0.3 meters. Position quality indicator 
provides estimated accuracy of each fix. 

● Standard position update rate of once per second for all targets. 
● Compatible with Desert Star depth-encoded pingers and US Navy standard DPSK 

pingers. 
● Broadband, DSP based design operating from 2 kHz to 80 kHz. 
● Simple surface equipment consisting of a junction/power box and a MS Windows 

notebook computer or desktop. 
● Client -server architecture supports tracking data viewing in remote locations via the 

Internet or LAN. 
● Uncomplicated and rugged hardware that enables use of locally available labor and 

vessels of opportunity. 
● A relatively low-cost design permits use in ‘risky’ locations where equipment loss is a 

possibility. 



 

RangeNav™ Systems consist of a number of interconnected listening stations linked to a surface junction/power box 

and PC. 

RangeNav™ systems are configured from the principal components listed in this chapter. In general, 
the information in this operator’s manual is sufficient for most tasks. Additional detailed information 
about the components is available in these RangeNav™ Manuals: 

RangeNav™ Technical and Software Reference Manuals 

1. The DiveBase RangeNav™ Software Reference Manual describes the surface station 
software. 

2. The TLP-100-101-102 Technical Reference Manual describes the standard pingers. 
3. The TLP-103 Technical Reference Manual describes a micro pinger for small targets. 
4. The RBS-100-101 Technical Reference Manual describes the listening stations. 
5. The STM-100 Technical Reference Manual describes the surface station junction box. 
6. The RPD275-550-1100 Technical Reference Manual describes the array data and power 

cable. 

RBS-100 Listening Stations 



 

At the core of a RangeNav™ system are a set of model RBS-100 broadband listening stations. The 
stations are linked in a daisy-chain fashion, with up to 100 stations per chain and a maximum 
supported chain length of 20 nautical miles if stations are spaced in 1km intervals. An anticipated 
expansion will allow the use of multiple chains, so that a coverage of up to 20nm x 20nm can be 
achieved. 

These ‘intelligent’ listening stations receive acoustic signals from the pingers through a broadband 
hydrophone and transmit transducer assembly that is attached to the station via a short (1.5m) 
cable. Signals are processed in the station using filter and telemetry decoding parameters provided 
per remote command by the surface station. Instation acoustic signal processing greatly reduces the 
data volume to a brief ping descriptor, which is transmitted via a RS -485 copper-based data link to 
the surface. 

In addition to their broadband acoustic receive capability, the listening stations are also equipped 
with an acoustic transmitter and transducer, operating at 16kHz – 24kHz. The acoustic transmit 
capability is used primarily for array selfsurvey, providing a speedy and very accurate means to 
determine station locations relative to each other. 

In order to determine precise depth of their location, each station is equipped with a 0.1% of full 
scale accuracy pressure sensor. The pressure sensor rating is 500 PSIA, supporting the station’s 
300m depth rating. Each station reports its depth to the survey as a part of the array self-survey 
process. 

The listening station are powered by 50/60Hz AC power from the surface junction box, and can be 
configured to operate at either 880 VAC or 440 VAC nominal. The higher voltage supports maximum 



chain length, but the lower voltage is a safer solution for applications or in areas where human 
interaction with the system is common. Each station relays both power and conditions and relays 
data down (and up) the chain. 

In addition to its main DSP processor, the listening stations include a micro-controller which is 
exercising supervisory function. These include a data and power bypass that is activated if the DSP 
chip is not responsive. The mechanism allows the remainder of a chain to keep operating even if the 
DSP circuitry in one station is defective. 

RBS-101 Recording Stations 

The model RBS-101 recording station are identical to the RBS-100 listening stations, except that a 
CF FLASH memory card is integrated and raw acoustic data recording firmware is provided. Due to 
its copper/RS -485 data interface, umbilical communication bandwidth is limited and not suitable for 
continuous raw acoustic data transmission by all stations in a chain. (Doing so is not normally 
necessary, because each station processes the acoustic data and needs to send only short ping 
descriptor packages). 

Yet, the RBS-101 station helps when there is a need to obtain occasional samples of raw acoustic 
data, such as to evaluate background noise or measure the noise signature of a target. The surface 
station can instruct any listening station to record the raw data. The data is stored in the FLASH 
memory, and can be retrieved by the surface station on a bandwidth available basis. FLASH card 
capacity is 1 GB standard 8 GB optional. The 1 GB standard capacity is sufficient for approx. 30 
minutes of raw data recording at the standard sample rate of 250 kHz. 

Data and Power Cable 



 

The RBS-100 listening station and RBS-101 recording stations are linked to each other and the 
surface junction box through the data and power cable. Cable sections of 250m, 500m and 1000m 
are available. Each section is terminated with wet-mateable (diver serviceable) underwater 
connectors and a ‘chinese finger’ strain relief system. 

The cables include a cut and abrasion resistant clear polyurethane jacket that supports inspection, a 
Kevlar braid strength member and water swelling tape to slow cable flooding in case of a cut. The 
maximum working load is 500lb and the breaking strength is 1500lb. The cable is negative buoyant. 

A 250m spool weighs approx. 85lb. The six-conductor cable includes an AC power pair, plus two 
twisted data pairs supporting two RS-485 data channels. 

STM-100 Junction and Power Box 



 

Each chain is terminated at the surface to a model STM-100 junction and power box. The principal 
functions of the STM-100 are power generation and handling and data relay between the underwater 
array and the surface station PC. 

The STM-100 connects to 50/60Hz AC power and is factory configured for either 110VAC or 
220VAC operation. It converts the power to either 440VAC or 880VAC before feeding it into the 
array. 

A power monitoring operates in conjunction with reports from the listening stations, and provides 
continuous reports about the voltage at each station and the current flowing through each conductor 
of the power pair. The power monitoring helps determine the max. available chain length (before 
voltage gets too low), and detect any faults such as leakage currents, defective station electronics or 
short circuits. For safety purposes, the STM - 100 also cuts power to the array if either a sudden 
current spike or a ground fault (current mismatch) is detected. 

The STM-100 also includes an input for a GPS time signal. In conjunction with a similar input 
available on the depth coded pingers, the time signal allows direct pinger-to-listening station 



distance measurements (as opposed to the normal distance differences obtained with 
unsynchronized pingers). This mode is sometimes used to improve the array GPS surveys accuracy 
and reliability. It yields station coordinates for each listening station individually, and completely 
independent of the other listening stations. 

Surface Station PC and Software 

 

The surface station PC connects to the STM-100 junction box via a RS-485 converter that plugs into 
a USB port on the PC. The converter and cable are supplied as standard accessories. A powerful 
Windows XP notebook PC is sufficient to service a maximum length chain, because the computing 
intensive raw acoustic data processing has already been performed by each listening station. 

The PC runs the RangeNav™ software, which computes and displays target tracks, resolves array 
self and GPS surveys and monitors the array health status. 

Due to the small size and minimal power demands of the surface station, it is quite practical to 
operate a RangeNav™ system from a trailer or control van using line power or a generator. 

TLP-100, TLP-101, TLP-102 and TLP-103 Depth Encoded Pingers 



 

The RangeNav™ system is designed to track pinger equipped targets. These may be standard U.S. 
Navy DPSK pingers, or Desert Star’s depth encoded pingers. Four pinger types are currently 
available: 

1. The TLP-100 low-frequency pinger operates at 8-16 kHz with a transmit power of 192 dB. 
It includes a precision 500 PSIA depth sensor, with an accuracy of 0.5 PSI. The TLP- 100 
yields the greatest range and therefore supports maximum station spacing. It is also the 
largest design. The TLP-100 is intended primarily for tracking submarines and large UUV. 

2. The TLP-101 is similar to the TLP-100, except that the frequency range is 16-24 kHz. 
This mid-frequency pinger is suitable for smaller vehicles as well as divers. 

3. The TLP-102 high-frequency pinger operates at 34kHz-42kHz, and is otherwise identical 
to the TLP-101 including a housing of the same size. The higher frequency produces 
somewhat less range and thus requires denser station spacing, probably not to exceed 
500m. In multi-target tracking, using this pinger along with models for the two other 
frequency bands provides better ping frequency separation for more robust tracking. 

4. The TLP-103 micro-pinger also operates at 34kHz-42kHz, but comes in a much smaller 
package. It is suitable for micro UUV, divers and other small targets. Transmit power is 
limited to 177 dB, and as such listening station spacing should not exceed 250m. Its 500 
PSIA depth sensor has an accuracy of 5 PSI. 



 

2. RangeNav™ Software, Firmware and Driver 
Installations 
SEALEVEL P/N 2104 RS485-USB Converter 

1. This converter is used for communication between the surface station PC and the STM 
-100 junction box. Prior to first use, open the black housing of the convert er using a small 
flat-head screwdriver for gently prying. Set switches 1-7 to the ON position and switch 8 
to the OFF position. This setting configures the converter for twowire RS-485 operation. 

2. Now connect the converter to a USB port of the surface station PC. The PC will detect 
the new device and start the hardware installation wizard. Insert the SEALEVEL CD ROM 
and follow the instructions of the wizard. 

RangeNav™ Surface Station Software Installation 

1. Insert the RangeNav™ CD ROM 
2. The CD should auto-launch. Follow the wizard instructions. If the CD does not auto 

launch, then use Windows Explorer to click on the Setup icon. 



3. Start the RangeNav™ software. 
4. Configure the software for communication with the STM -100 junction box by selecting 

the COM port that the SEALEVEL converter has been assigned to. Do this by selecting 
Setup→Data Connections from the main menu. The figure below shows proper 
configuration through a SEALEVEL device on COM4. The standard baud rate is 115200 
baud. 

 

Figure 1: Configuring the connection between the PC and the STM-100 Junction Box 

Updating the RangeNav™ Array Firmware 

 

Figure 2: Firmware Update 

The firmware on the RBS-100 listening stations, RBS-101 recording stations and STM-100 junction 
box is updated on occasion. New firmware can be downloaded to the entire array while deployed, or 
it can be downloaded to individual stations or a set of stations at the maintenance depot. 
Downloading new firmware to a deployed array is an acceptable practice to test newly developed 



capabilities. However, you should always have a production approved version of the firmware at 
hand, to revert to in case a bug should become apparent. 

To update firmware, connect the array as you would for operation (PC to STM-100 to a number of 
RBS-100 or RBS-101 stations). Then, power up the array. (If you use automatic power-up, make 
sure the Start Application on Power Up check box is not selected). Next, select Setup→Update 
Array Firmware. Click the Update Firmware button and select the new firmware file in the browser. 
The firmware has a .VC extension. The window will show progress information. Once download is 
completed, click the Run Application button to launch the updated firmware. 

3. Systems Wiring and the Array Power Up / Down 
Procedure 
System Wiring 

Wire a RangeNav™ system for operation as follows: 

1. Link the surface station PC to the STM-100. A USB port on the PC connects to the PC 
port of the STM-100 using the supplied SEALEVEL RS -485 converter and STM-100 data 
cable. 

2. Connect the STM-100 to 50/60 Hz AC power (110VAC or 220VAC only as indicated on 
the STM-100 panel) using the supplied marine power cord. 

3. Connect a hydrophone / transmit transducer assembly to each RS -100 listening or 
RBS-101 recording station. The transducer assembly connects via a 1.5m 4-conductor 
cable. 

4. Use an umbilical cable section (275m, 550m or 1100m spool depending on desired 
listening station spacing) to link the STM -100 junction box to the first RBS-100 listening 
station or RBS-101 recording station. The cable section links the ARRAY connector of the 
STM -100 to the ‘upstream’ connector of the listening/recording station. (The connector 
polarity arrangement assures correct connection). 

5. Connect the ‘downstream’ umbilical connector of the first listening station to the 
‘upstream’ connector of the second listening station using another umbilical cable section. 
Continue in this fashion to the end of the chain. 

6. Terminate the downstream connector of the last listening station or cable section with a 
dummy plug to prevent a water short circuit of live wires. 

7. Optionally, connect the one-second time signal output (TTL signal) of a GPS receiver to 
the GPS input on the STM-100. The GPS time signal can be used to synchronize the 
listening station array to GPS triggered pingers for improved absolute (earth coordinate) 
array surveys. 

System Power-Up Procedure 



The RangeNav™ system uses power relaying. 440VAC or 880VAC power is injected by the 
STM-100 junction box into the ‘upstream’ end of the array. The power reaches the first listening 
station, which relays the power on command to the second listening station and so on until the entire 
array is energized. Power relaying allows operation of an only partially energized array, such as to 
operate an array upstream of a cable cut (short circuit avoidance), to allow service at a point of 
failure, or when only a partial array is needed for a tracking task. 

The RangeNav™ system also monitors the current flowing through each of the two power 
conductors, and the voltage seen across the conductors in real-time. The electrical current data is 
useful as an early warning sign of impeding failure such as due to a bad connector, cable cut or 
deteriorating transformer. It is also used by the RangeNav™ safety system to automatically cut 
power if a ground fault (current imbalance) or a current spike has been detected. The safety system 
minimizes the risk of both electrocution and equipment damage. 

The power up sequence for the array can be executed automatically, or listening stations can be 
powered up or down individually using the manual power procedure. 

Automatic Power-Up 

 

Figure 3: Array Power Window, Automatic Tab 

Use this procedure to execute a standard power-up of the entire array. 

1. Select Array→Power 
2. Select the Automatic  tab. 



3. Leave the Start application on power up  tab checked if you wish to initiate tracking 
immediately following the power-up. Un-check the box if you are powering up the array in 
order to update firmware or perform other maintenance functions. 

4. Hit the Start Power Up button. 

Automatic power-up now starts, one station at a time. As each station is powered up and 
communicates, its serial number appears and a bra indicates the AC voltage seen by that station. 
You will also see the AC current rise with each energized station. Familiarize yourself with the typical 
‘look’ of the voltage curve and the incremental current increase. This will help you spot problems 
down the road. Each station power-up and initialization typically takes 10-20 seconds. If the surface 
station does not see communication from another listening station within 30 seconds of energizing 
the next cable section, it assumes the entire array is powered up. The array power-up completion 
pop-up window then appears. You are now ready for tracking operations. 

Manual Power-Up 

Use this procedure to manually power-up (or down) one station at a time. Manual power-up provides 
more operator control and is available for various diagnostic and maintenance purposes. 

 

1. Select Array→Power 
2. Select the Manual  tab 
3. To power up the next station, hit the Power-Up  button. 
4. To send a power up or down command to a specific station (i.e. power up/down the next 

station downstream from that station), select its serial number in the list and hit the 
Power Up  or the Power Down  button. 

5. To verify umbilical communication with all stations and re-establish their serial numbers, 
hit the Enummerate  button. This is useful to determine if a station’s main processor may 



have failed and has been bypassed by the station’s supervisory processor. In that case, 
its serial number will no longer appear but stations further downstream may still be 
available. 

6. To start or stop power monitoring, hit the Start Power Monitor / Stop Power Monitor 
button. In general, it is recommend to keep power monitoring active at all times. An 
exception might be to conserve umbilical communication bandwidth for tracking functions 
in a large array. 

7. To start the tracking application following manual power-up, click the Start Application 
button. Once started, you cannot exit an application. Instead, it will be necessary to 
power-down and the power-up the array if you wish to perform functions such as firmware 
update. 

8. Click the Log data  check-mark if you wish to record all power data. Use this capability to 
create a power log for diagnostic or Desert Star technical support purposes. 

Array Power-Off 

To quickly power-down the entire array, flip the STM-100 power switch to the OFF  position. You can 
also go to the manual power screen, select the first station (this is actually the STM-100) and send it 
a Power Down command. Use a similar procedure if you wish to power-down a portion of the array. 

Detecting and Dealing with Power Faults and Array Size Limitations 

RangeNav™ operators should make it a habit to monitor the power characteristics of the array. This 
will allow you to notice early warning signs of faults such as leakage currents due to a bad cable or 
connector, or a bad listening station before such a problem causes an automatic array shut-down. 
Further, the ‘voltage curve’ formed by the sequence of listening stations indicates when you are 
approaching the maximum available length of the array due to excessive voltage loss. The following 
list provides some advice on these matters. 

● The low-voltage limit for arrays configured for 440VAC operation is 240VAC. Array 
voltage will drop in each cable section due to cable losses. When the last station sees 
240VAC, you have reached the limits of operation and the array cannot be extended any 
further. The low-voltage limit for arrays configured for 880VAC operation is 480VAC. 

● Each additional listening station will increase current in the array by about 15mA – 30mA. 
If you see an incremental current above 30mA, the downstream end listening station may 
be defective. If the incremental current is below 15mA, then the station is probably not 
seeing power such as because you are at the end of the array (no further stations) or 
because there is a broken power conductor. 

● A cable by itself without a further station will in fact consume power. That is due to the 
capacitive and inductive characteristics of the cable in conjunction with its ohmic 
resistance. If you daisy-chain two or more cables without a station, you will see a higher 
incremental current for that extended cable section. 

● The incremental current curve may not be completely even, because energy is stored in 
the cable system’s capacitive and inductive characteristics and some currents may 
circulate locally. 



● There are signs that a given listening station may in fact see a slightly higher voltage than 
its upstream neighbor. This may be due to localized energy storage in the cable. 

4. Defining The Array Operating Frequencies and Signal 
Monitoring 
RangeNav™ is a programmable broadband system, with frequency coverage from 600Hz to 80 kHz. 
Prior to operation, you must define the operating frequency channels, both for the array and the 
pingers. The single-target version of RangeNav uses three channels: 

● Channel 1 is the self-survey frequency. This should always be 16 kHz. 
● Channel 2 is the synchronization frequency of the depth coded pinger. It is pinger model 

specific. 
● Channel 3 is the depth telemetry ping of the depth coded pinger. The frequency is pinger 

model specific. 

Operating frequencies and filter characteristics are defined by FIR filter files, which have a .fir 
extension. Table 1 lists currently available filter files. 

Filter Name Center 
Frequency 

Bandwidth (@ 
-3dB) 

# of 
coefficients 

Use for 

16000Hz.fir 16 kHz 800Hz 398 Ch. 1 self survey 

8492Hz.fir 8.4925 kHz 800Hz 398 Ch. 2 for TLP -100 

10498Hz.fir 10.498 kHz 800Hz 398 Ch. 3 for TLP -100 

16528Hz.fir 16.5289 kHz 800Hz 398 Ch. 2 for TLP -101 

18518Hz.fir 18.5185 kHz 800Hz 398 Ch. 3 for TLP -101 

34482Hz.fir 34.4828 kHz 800Hz 398 Ch. 2 for TLP 
-102/103 

36363Hz.fir 36.3636 kHz 800Hz 398 Ch. 3 for TLP 
-102/103 



Notes: 

1. The filter bandwidth defines the frequency range passed by the filter. A larger bandwidth accepts a higher 

maximum target speed (allowance for Doppler effect) and yields better ping time detection accuracy. It also 

passes more noise and therefore reduces the maximum detection range. 

2. In order to achieve desired filter characteristics, a certain number of filter coefficients is needed. In general, 

sharper filters (less bandwidth and/or better stopband rejection) also require more coefficients. However, a filter 

with more coefficients will increase the time-uncertainty of ping detection, resulting in reduced tracking 

accuracy. The processing power requirement also relates to the number of coefficients. 

Table 1: FIR Filter Files 

Programming the Channel Frequencies of the Array 

 

Figure 5: Defining Operating Channels 

1. Select Array→Channel  Editor 
2. To add a new channel (you must have three channels defined for single-target tracking), 

hit the Add button 
3. Select the .fir filter file for the first/next channel in the browser, using table 1 for guidance. 

The next free channel number will be automatically assigned. 
4. To change a channel definition, select the channel in the list and hit the Edit button. 



5. To delete a channel, select the channel in the list and hit the Delete button. The 
remaining channel numbers will be re-assigned. 

6. Once your channel definition list is complete, hit the Download Channels to Array button 
to download all channels to all energized listening stations. 

Programming the Channel Frequencies of the Pinger 

1. Connect the pinger to the COM port of the MCU-5 charging/configuration station. 
2. Connect the USB port of the MCU-5 station to a USB port of your PC using a standard 

USB master/slave cable. 
3. Start the HyperTerm utility on the PC, select the assigned COM port and select 4800 

baud 
4. Follow the prompts or pick up the technical reference manual to see how to configure the 

pinger. 

5. Deploying and Recovering the RangeNav™ System 
All RangeNav deployment techniques require assembling the chain of cable sections and listening 
stations. Depending on the deployment technique, this may be done prior to boat departure or while 
the deployment is in progress. The assembly process is as follows: 

1. Connect each listening station to its stainless steel strong-back and lead weights, making 
sure it is well centered. Use two stainless-steel hose clamps to secure the station. Loop 
the hose clamp around the station and strong back, and through the two slots of the 5 lb 
lead weight. Place a 1/8” thick neoprene rubber pad between the station and the strong 
back at each hose clamp. Important: The rubber pad is needed both to avoid 
longterm bending of the Delrin station housing and as part of the shock absorption 
system. Do not omit it.  Tighten the hose clamps only moderately (approx. 12 
inch-pound). The station should be snug, but still be able to slip somewhat if dropped on 
deck onto the end of the strong back. This is part of the shock absorption system. 

2. Connect the hydrophone/transducer assembly to each station using the supplied cable. 
Make sure to secure the locking sleeve on both ends of the cable all the way to assure a 
positive connection. IMPORTANT: Secure the cable ends to the strong back using 
cable ties. This is necessary to prevent repeated flexing at the connector, which 
has been shown to cause long-term failure of the data conductors due to stress. 

3. Connect the supplied or an alternate flotation device to the transducer assembly. The 
supplied float is 6” diameter, provides about 3.8 lb of flotation and has a maximum 
working depth of 400m. Use larger floats if there are substantial water currents in the 
area. Keep in mind that more weight may be needed as well. 



 

Figure 6A: Rigging the Listening Stations for Deployment 

 

Figure 6B: Listening Station Rigged with Strong-Back & Weights 

The RangeNav™ array consists principally of listening stations interconnected by cable sections. 
There are several deployment techniques, each with its own set of advantages and disadvantages. 
Recovery is generally the reverse of the deployment process. 

Array assembly while deploying 



Cable sections and listening stations may be stored unassembled on deck and/or in the hold. Each 
cable section is on a spool. For deployment, a cable section is mounted on an un-powered rack and 
cable is spooled out over the stern of the boat. As a spool is almost paid out, the boat slows and 
stops. The crew connects the next listening station and mounts the next spool. The process 
continues to the end of the array. To aid recovery, the empty spools are mounted on a winch. 

This method requires least cable handling equipment and can therefore be done from very small 
boats. It has excellent electrical safety, because the crew is not handling energized cables. 
However, the approach is very labor intensive and it may be difficult to keep the boat steady at the 
ends of sections as listening stations must be connected and spools swapped out. There is also no 
array monitoring during deployment, and thus faults will not be uncovered until deployment is 
complete. 

Deploying multiple pre-assembled sections from a figure-8 rack 

A number of cable sections and listening stations are interconnected on shore and the cable is 
figure-8 mounted across two posts. The upstream end of the array is connected to the STM-100 and 
the entire array is energized and tested prior to deployment. During deployment, the array remains 
energized for continuous monitoring. The cable is deployed over the stern of the boat, and listening 
stations are lowered into the water as the end of each section is reached. If the rack cannot hold all 
sections, then the downstream end of the last cable section is terminated with a dummy plug, 
equipped with a flotation device and left floating in the water. A new set of sections is assembled, 
loaded and tested. It is connected to the array, and the process continues. 

This technique supports array testing prior to deployment and monitoring during deployment. 
Problems are therefore quickly noted and corrected. Cable handling equipment requirements are 
minimal, and support use of a small boat. There is no need for the boat to stop at the end of each 
cable section, allowing for a more precise deployment. However, the figure- process is labor 
intensive and care must be exercised because the crew is handling energized equipment. 

Mounting multiple sections on a large, powered winch 

A number of cable sections and listening stations are pre-assembled and mounted on a large winch. 
The winch is equipped with holders for the listening stations. The winch is also equipped with a slip 
ring, so that the array can be energized and monitored. The cable and listening stations are 
deployed over the stern of the boat, and the winch power is used during recovery. 

This process requires least labor during deployment and recovery. It supports array testing prior to 
deployment, and monitoring during recovery. However, it also requires a large winch and a larger 
boat to handle the equipment. Care must be exercised because the crew is handling energized 
equipment. 

6. Conducting an Array Self-Survey 



The acoustic self-survey measures the distance of the listening stations relative to each other. This 
information in turn is used to compute the coordinates of the stations, expressed as meters ‘north’ 
(northing) and meters ‘east’ (easting) of a point of origin. You will need to pick three ‘anchor stations’ 
as a starting point for the system’s listening station position computations. You do not need to know 
the exact location of those three stations, but they should be located in a triangle configuration as 
opposed to a line and must be within range of each other. This will give the best results. 

Anchor station #1 will become the origin of the coordinate system (N=0;E=0). The line between 
anchor station #1 nad anchor station #2 forms the easting axis, and therefore the location of anchor 
station #2 will always be a Northing of zero and an Easting equivalent to that station’s distance from 
anchor station #1. 

Follow this procedure (see screen dump below): 

1. Select the Acquire Data  tab in the array survey window. 
2. Enter a reasonable Cycle Count  such as 5 or 10 tries. A greater number of cycles 

(distance measurement attempts per station pair) results in better data quality due to 
averaging, but also takes more time: one second per cycle per station. 

3. Enter a sonar Transducer Depth Offset . RangeNav measures all depths relative to a 
vacuum reference ( 0 PSIA). This allow the system to compensate for changing 
atmospheric pressures be it due to weather systems or because you are operating in a 
high altitude lake. The depth offset also allows you to compensate for the length of the 
listening station sonar transducer cable (normally 1.2m) In order to obtain the correct 
depth of the sonar transducer, enter the atmospheric pressure expressed in meters of 
sea water PLUS the length of the sonar transducer cable. For oceanic work not during a 
hurricane or extreme low pressure system, the atmospheric pressure will be around 10m, 
resulting in a entry of about 11.2m (10m + 1.2m). 

4. Click the Depth Survey  button to obtain the listening station depth from their sensors. 
5. Clicking the button Entire Array  starts the acoustic self survey. Survey progress, 

including the current cycle count is reported in the white status window in the lower right. 
The range numbers in the matrix fill in as each range is obtained, and the Valid  entry for 
a station turns green once sufficient survey data for that station is available. You can stop 
the survey at any time by button press, or select a station row and then press Single 
Station  if you wish to obtain self survey data for that specific station. 

6. When the acoustic self survey is complete (and all or most station’s Valid  field has turned 
green), proceed to the Calculate Positions  tab. Select three anchor stations (see 
explanation in the introduction above), and then click Calculate Positions . The software 
will now compute the relative position of all the stations, and display them as Northing 
and Easting coordinates. The residual error for the overall survey is displayed in the 
status window, and the error for the position of each station in the Survey Data  display 
row of that station. The residual error is roughly equivalent to the position uncertainty of a 
station (or the average for all stations). A smaller number means a better result. You can 
change the anchor station selection and click Calculate Positions  again to see if a better 
/ more certain result might be obtained. 



The below table explains how to explain the screen shot. 

 

Figure 7: Array Self-Survey Screen 

Survey Display 
Data Field 

Interpretation 

Station # (example 
Station 10) 

The number of stations in the array is displayed in the upper left 
corner 

Depth The depth of the station, as measured by its pressure sensor 

N The Northing location of the station 

E The Easting location of the station 

Valid Yes/No— Sufficient survey data to calculate the station position is 
available 

1st Number—Number of other listening stations that heard the ping 
from this stn 



2nd Number—Residual position error (position uncertainty) for that 
station 

Explanation of 
Colored Areas 

Red Question Mark—Means no data 

Yellow Block— Data available, but considered unreliable and not used 

Green Block—A valid position for this station is available 

Red Block—Sufficient data for a position computation is not available 

Calculate Positions 
tab 

Use to calculate station positions following a acoustic self survey 

Acquire Data tab Depth Survey—Press to obtain the depth of all listening stations 

Single Station—Acoustic self survey for that station only 

Entire Array—Acoustic self survey for the entire array 

Transducer Depth Offset—Compensation for atmospheric pressure 
and sonar transducer cable length 

Cycle count—Desired number of range survey cycles 

Figure 8: Self Survey Screen Data & Controls 

7. Tracking Operations 



 

Figure 9: Tracking Display 

Tracking Display Information & Control Summary 

1. The Current Target Position is a small rectangle with the target ID code. The 
single-target version of RangeNav uses the ID code M1 (mobile station #1). 

2. The Position Trace provides a history of target positions. Each position fix is one small 
cross. Many individual fixes in random locations, such as on the map above, indicate that 
the position filter settings are not stringent enough and should be changed by selecting 
Mobile → Position Estimation Filter → Settings . If the screen gets to cluttered, select 
Mobile → Clear Track . 

3. The Variable Grid Scale should be set to provide convenient scaling, such as for 
example 10m or 100m per grid line. Select View → Settings . The view menu is also 
used to select the tracking display Pan, Zoom and Rotate functions. Select one of these 
functions, point the cursor at the screen, left click and drag. If in Zoom mode, use left click 
to zoom in and the ‘–‘ key to zoom out. There is also a convenient Measure function. 
Select it, point, left click and drag to obtain distance and direction between two points. 

4. The Target Depth Display uses a slider to display the report of a depth encoded pinger. 
5. Numerical Target Information is available in the green display in the lower right corner. 

Here you find the target information expressed as Northing and Easting, the Depth, and 
the time since last position fix in minutes and seconds (A). The Error value in the lower 
right relates to the estimated accuracy of a fix, with a larger number corresponding to a 



greater error. This number currently is in arbitrary units, but our goal is to provide an error 
estimation in meters in the future. 

6. The Listening Station Locations are small squares with the listening station serial 
number. Color indicates the status of that station. Red means the station has not reported 
a signal from the pinger, and green means that this station is seeing and reporting the 
pinger signal. As a pinger moves through the array, you can expect to see it surrounded 
by a ‘cloud’ of green stations that track its progress. A station symbol may also be blue. 
That means the station is powered up, but is still sitting in the boot loader and is NOT yet 
running the application. You will see this when doing a power-up sequence without 
commanding the stations to run the application (for example in preparation for a firmware 
update). 

7. The Listening Station Status Lights provide the status of all listening stations at a 
glance. The lights are not labeled, but the sequence corresponds to the physical listening 
station chain. If there are too many stations for one line of lights, then the software 
displays multiple lines. Read row by row from upper left to lower right. The color encoded 
status information is the same as for the listening station location displays. The listening 
station lights use the same colors as the listening station location symbols (see above). 
Blue means the station is in the boot loader (powered up, but not running the boot 
loader), red means the station is not seeing a pinger signal, and green means the station 
is seeing and reporting pinger signal information. In addition, the status lights use shades 
of red and green. A bright red or green will appear each time a report from that listening 
station has been received. The color will then darken over a number of seconds until it is 
black. A healthy station will report once per second, on so its color will stay bright with 
slight pulsing noticeable. If properly synchronized to each other, all stations will also 
report at approximately the same time. So, a well working system will display a consistent 
and synchronous ‘heart beat’ of all stations, with each station either being red or green 
depending on if it is in the transmission range of the pinger. 

RangeNav has two principal modes. Replay mode  is available to review tracking data and is 
discussed in the next chapter. Real -Time mode is used for tracking and array survey alike. 
Real-time mode is active whenever Replay mode is NOT selected, i.e. it is the default mode. When 
in replay mode, you can switch to real-time mode by selecting File→Switch to Realtime Mode . 
Assuming you have already powered up the listening stations, conducted an array survey and 
defined the channels used for ping pinger detection, you will be ready for tracking. The display will 
now be similar as seen above. 

The following is a recommended sequence used to initiate tracking information following a 
successful system power-up and listening station survey. Most steps and the sequence is not 
mandatory, so your method may vary. 

1. Conduct a noise test: Array→Signal Envelope  Select the Bar Chart display. Choose all 
the stations by highlighting them, then chose Channel 2, and finally choose 5 Hz…hit 
Start. Watch the noise peaks on the chart, expressed in dB. 

2. Now set the receiver detection thresholds of all stations to be above the noise peaks that 
you noticed in the first step. Do this by going to Array→Acoustic Receiver Settings . 



Here, you must also set the post ping-receipt Blackout Period  to be somewhat less than 
the expected ping interval. This blackout period helps the system to discriminate against 
echoes. The recommendation is 100ms less than the nominal ping interval, for example 
900ms for a 1 second ping interval (if you are too close to the ping interval, such as 
perhaps 990ms for a 1 second interval, then the system may persistently home in on one 
specific echo). 

3. To rule out any outside noise distractions that might register, go to: Mobile→Position 
Estimation Filter→Settings . These Range Filter options determine the treatment of 
pinger signal reports from individual listening stations (i.e. raw ranges): 

1. Maximum Range:  The maximum accepted distance from a listening station. 
Use to eliminate impossible or undesirable large and probably unreliable 
measurements. 

2. Minimum Signal Strength:  Signal reports below this strength are considered 
unreliable and will be rejected. 

3. Maximum Jitter:  If two successive reports from a listening station indicate an 
apparent distance change more than this amount, then the report is 
considered unreliable and will not be used.  

4. These Position Filter  options determine the treatment of target positions 
computed from multiple pinger signal reports. 

5. Averaging Period:  Averaging is used to reduce the impact of random range 
measurement variations (noise) on the position computations, and thus 
provide a more accurate depiction of the actual position trace. This is a 
running average over the specified number of seconds. The appropriate 
averaging period for a slow target such as a diver may be ten seconds. A 
rapidly moving and turning target such as a torpedo will require a shorter 
averaging period to reduce position lag. 

6. Maximum Error:  This is the maximum estimated position uncertainty that will 
be accepted. Position fixes with a greater uncertainty will be rejected. 

4. Select the tracking file name by using File → New Track Record . The Automatic File 
Name  option assigns the tracking file a name consisting of the start time and date. Use 
the Custom File Name option to assign a more descriptive name. In either case, the 
tracking data will be a .TRK file stored in the RangeNav/Records/Track  folder. The .TRK 
files are text files that contain all acquired raw tracking information in a text format. They 
are used to replay a track (see discussion in next chapter), and are available to export the 
tracking data into other software such as Excel for analysis. See the RangeNav Software 
Technical Reference Manual for details. 

5. Some of the data windows allow you to log the data as well as viewing it. All logs are in 
text format. The data logs are useful to diagnose system performance, such as for 
example reviewing electrical logs to monitor cable, connector and electronics health. The 
available logs are: 

1. Array →Power Control:  Array current draw and voltage reported by each 
listening station. 

2. Array →Signal Envelope:  Acoustic signal seen on a specific channel. Useful 
to monitor background noise or ‘see’ the pinger signal. 



3. Array →Time of Arrival:  Ping time of arrival reports from all listening 
stations. Can be used to recompute target positions. 

6. Activate the target pinger and start tracking. Move around the display using these 
functions. They are also described in the box above. 

1. CTRL-Z: Zoom, zoom a rectangle (zoom in +, zoom out -) 
2. CTRL-M: Measure, circle from-to 
3. CTRL-P: Pan, hand. Center on mobile by clicking on mobile box. Center on 

listening station by clicking on its status field. 
4. CTRL-R: Rotate, pie chart from center 

 

Figure 10a: Step 1—Noise Test 

 



Figure 10b: Step 2—Threshold Level 

 

Figure 10c: Step 3—Position Estimation Filter Settings 

 

Figure 10d: Step 5—Power Control window with Log data button 



 

Figure 10e: Step 5 —Time Of Arrival window with Log data button 

 

Figure 11: Tracking a pinger in a pool 

In this exercise the transducers were the only component in the water (other than pinger). I used a 
TLP-102 and walked it around in a circle from inside the pool leaving it in the middle as I walked. 
Over the course of a minute I made a complete circle and turned the pinger off. If you were watching 
this in real-time then you would see the Baseline Stations glowing green as they received the pings. 

8. Replaying Tracking Records and the RangeNav™ Data 
Files 
Tracking records can be replayed in Replay Mode . Tracking data is also available in text files. 
These files can be imported into other software for further analysis of your tracking data. 



To play back a track record, simply go to FileàReplay Track Record and then find the corresponding 
track that you want to replay (figure 12). This will then bring up some controls (see figure 13). All 
tracking data is recorded in raw format, i.e. signal arrival times, signal strength etc. Prior to playing 
the record, you must define your filter settings in Mobile → Position Estimation Filter . Then, select 
File→Reprocess Data . 

 

Figure 12: Selecting A Track To Replay 

From here you can play the current track as well as pause it, stop it, fast forward or rewind it, and 
skip to any point in the track. Refer to the controls listed in figure 13. 

 



 

Figure 13: Controls During Track Replay 

 

Figure 14: A recording played with no (left), limited (center) and strong (right) filter settings 

RangeNav™ stores the full tracking record in a text file with a .trk extension. In addition, select data 
such as times of arrival can also be stored in log files, which are text files with a .log extension. 
These files are available for analysis of your tracking data using your own software tools. Figure 15 
shows a portion of a .trkfile as it appears in Notepad. Refer to the RangeNav™ software manual for 
a full description of these files. 



 

Figure 15: How To Read Array Survey Data 

9. System Maintenance 
Most of the components of RangeNav do not require much maintenance. Refer to specific technical 
reference manuals for maintenance on each component. Here are the overall system maintenance 
guidelines: 

● Rinse your equipment off when finished (listening stations and pingers). Pay in articular 
attention to metal components such as the connectors and depth sensor. 

● Prevent excessive water falling onto the STM-100 surface junction box. It is only splash 
proof. Clean the STM- 100 with a dry or moist towel. 

● Check all cables prior to deployment and upon recovery. Do not use any damaged cable 
to avoid compromising the entire system. 

● Apply a thin film of silicone grease to the rubber molded underwater connectors before 
mating. 

● Thread the locking sleeves of all connectors until they come to a full stop against the 
bulkhead connector. This is essential to ensure reliable connections. Inspect before use! 

● Properly attach the cable strain relief system before use. Inspect your work, paying 
attention that the shackles are secured in the locked position. 

● Do not exceed the 500lb working load of the cable. 
● Do not violate the 6” minimum bending radius of the cable. 
● Inspect the cable upon recovery and set aside any damaged or questionable sections for 

repair or test. 
● Check back periodically on www.desertstar.com for firmware updates and new 

Knowledge Base entries. 
● Most importantly, enjoy your underwater tracking work and thanks for using RangeNav™! 

 
 

http://www.desertstar.com/
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1. Introduction 
The RangeNav system including the surface station software was designed to be very user friendly. 
The essential software functions and their use are described in the RangeNav™ operator’s manual. 
The operator’s manual in conjunction with some experimentation suffices to understand the most 
significant software capabilities and their use. This manual serves as a supplemental reference. It 
describes the function of all software functions, sorted by their menu locations. Scan over it to learn 
all the capabilities of the software, or use it to understand the capabilities and use of a specific 
software function. 

2. The Main Menu 
This section describes RangeNav™’s main menus at the top of the main window (File, Array, etc). It 
will give you the function of each menu drop-down list. 

2.1. File Menu 

Use this menu to call up a record file for replay, start, stop and delete records etc. 

Option Function 

Replay Track 
Record 

Replay a recorded track for study. Select the desired track record (.trk 
file) in the file browser 

Switch to Realtime 
Mode 

Changes back to real-time tracking mode from replay mode 

Load Array Survey 
Data 

 

alternative to conducting a new array survey if you know that your listening stations have not moved 
(i.e. they are well anchored) since that survey. Using the same survey data for all tracking operations 
provides better repeatability and consistency of the track records. | 

Delete Logs Calls up a file browser that lets you delete log files that are no longer needed. 
Specify the files to be deleted in the browser window. 

Delete Raw 
Records 

Calls up a file browser that lets you delete raw record files (.dat files) that are 
no longer needed. These files contain the actual ‘raw’ communications 
received from the listening station array. Their use is primarily for bug 



documentation purposes. Specify the files to be deleted in the browser 
window. 

?Save Raw 
Records 

Click on this option to start or stop saving the raw tracking data. Desert Star 
may ask you for some raw records if you are reporting a bug. 

File Record 
Paths 

Allows you to designate what folder (other than the default) you want tracking 
files to be saved in 

New Track 
Record → 

Start saving a new track record (.trk file). You can select either automatic or 
custom name assignment. Automatic names consist of the file start time and 
date. Use a custom name instead to describe the operation shown by this file. 

Pause 
Track 
Recording 

Allows you to pause but not end track recording, such as when nothing of 
interest is happening. 

Exit Closes the software 

Table 1: File Drop-Down Menu 

 



Figure 1: File Drop-Down Screen Shot 

2.2. View Menu 

View menu functions adjust the tracking display. In most cases, your menu selection will activate a 
cursor function such as pan or zoom. These functions are identified by the ? symbol in the table. 
Several functions are also available through keyboard commands, which are listed in the table. You 
need only to hold the “control” button and press the stated letter. 

Option Function 

?Pan 
Ctrl+P 

Select to pan the display in any desired direction. Left click and drag the disply 
with the cursor as needed. 

?Zoom 
Ctrl+Z 

Select to zoom the display in/out. Use left click or ‘+’ to zoom in. Use ‘-‘ to zoom 
out. The ‘-‘ and ‘+’ keyboard commands can be used at all times, even when the 
zoom function is not selected on the menu. 

?Rotate 
Ctrl+R 

Rotates the display including the grid lines in directions needed. Left click and 
hold, move mouse clockwise or counterclockwise. A pie chart appears during 
rotate to illustrate the operation. 

?Measure 
Ctrl+M 

Measure distances between any two points. Left click on the start point, then 
hold and drag to the end point. A circle chart with numerical distance and 
direction (degrees) will appear. 

Reset 
Rotation 

Resets the display rotation to the default (zero degrees) 

Settings This allows you to view and set the exact screen settings numerically. 
Everything changed in here are viewing options: grid size, color, screen 
background and text color, and various others 

Show 
Replay 
Controls 

Brings up the replay controls (play, stop, rewind, etc) This is in case you 
accidentally or on purpose dismissed the controls in replay mode. 

Table 2: View Drop-Down Menu 



 

Figure 2: View Drop-Down Screen Shot 

2.3. Array Menu 

The Array menu options are related to the group of listening stations, i.e. the array. Here is where 
you power up the array, initiate a listening station position survey, and perform various other tasks 
defined in the table below. 

Option Function 

Status No function yet; for future use 

Acoustic 
Receiver 
Settings 

Adjust the detection threshold and post ping reception blackout period of all 
pingers. These options are for fine tuning the detection of pingers, and their use 
is explained in the Operator’s Manual. 

Power 
Control 

Calls up the array electric power control and monitoring window. The power 
control and monitoring functions and techniques are explained in the Operator’s 
Manual. 

Signal 
Envelope 

Calls up the acoustic signal envelope display window. This window is used for 
example to conduct an ambient noise test or to watch the pinger signals. 
Practical use is explained in the Operator’s Manual. 



Time of 
Arrival 

Displays the ping time of arrival window, which provides numerical information 
regarding the detection of pings. This window is sometimes useful to monitor 
array performance. For example, a valid signal from a pinger that transmits 
once per second should show up at the same position (microseconds) within 
each 1 sec interval. If detection times are random, the station is picking up 
noise and the detection threshold should be raised. 

Survey 
Relative 

This calls up the listening station array survey window. A listening station 
position survey must be conducted before tracking operations can proceed. 
The Operator’s Manual explains how this is done. Refer to the following 
subchapter for a description of the menu options available in the array survey 
window. 

Load Array 
Survey 
Data 

Loads previous array survey data. When you know the listening stations have 
NOT moved locations, use this option for best data consistency. This function is 
identical to one of the same name in the file menu. 

Table 3: Array Drop-Down Options/Functions 

 

Figure 3: Array Drop-Down Screen Shot 

2.3.1. Survey Window Menu 

The survey window is called up by selecting Array→Survey from the main menu. It’s function is to 
initiate and execute a position survey of the listening stations in preparation for tracking. The survey 
process is described in the RangeNav™ Operator’s manual. 



The following tables describe the pull-down menus of the Array Survey window. 

File Menu 

Option Function 

Load 
Survey 

Load a saved survey (see next option) for use in tracking. Use this option to use 
‘your best’ survey result for all tracking operations if you know that the location of 
the listening stations has not changed. Calls up a file browser. 

Save 
Survey 

Save the current survey results. Use to have the survey available for later tracking 
operations. Calls up a file browser. 

Clear 
Survey 

Clears the current survey result so that you can initiate a fresh survey. If you don’t 
do this, then any data that has previously been collected will be maintained and 
influences the average of all measurements that constitute a survey. 

Clear 
Array 

Clears the array definition, i.e. the system will ‘forget’ which stations are in the 
array. You can do this to clear the screen of old and confusing data, perhaps 
left-over from a previous tracking operation. 

 

Filter Menu 

Option Function 

Settings Call’s up a window to define the filter settings used in the computation of listening 
station locations from the inter-station distance measurement results of the 
survey: 

• Minimum Range: Inter-station distance measurements less than this amount 
will be ignored. Set this parameter to the minimum plausible station distance to 
reject false measurements that may occur due to acoustic noise in the 
environment. Set this value to 5m or more. 



• Maximum Range: Same as above, but rejects measurements that are too 
large to be plausible or reliable enough for use. Use a setting of around 2-4 times 
your nominal station spacing. 

• Minimum Avg Signal Strength: Rejects distance measurements between 
stations with a signal strength less than this dB number. Weak signals also may 
be unreliable, and thus should not be considered in the survey. We recommend 
a setting of 110 dB, or different if supported by your tests. 

• Maxim Stdev: If the set of distance measurements between a given station pair 
exceeds this standard deviation, then the measurement will not be used in the 
position computations. High standard deviations indicate that a measurement is 
unreliable, perhaps because the direct acoustic path between the stations is 
obscured and only sporadic reflected signals are received. Use a setting of not 
more than 5m, less to follow more stringent quality controls. 

• Minimum Number of Range Measurements: If less than this number of 
measurements are available for a station pair, then the data will not be used. Use 
to ensure sufficient averaging. Minimum recommended setting is three 
measurements. 

 

Adjustments Menu 

Option Function 

Transform Used to transform the location of the array on the northing/easting grid, such 
as to convert from the array relative results of an acoustic survey to UTM 
coordinates. This pops up a window that provides you with two tabs and a few 
options. 

• Translate Tab: Shifts the entire array by the specified distance along the 
North-South and East-West axis. Hit Apply after defining your translate, Clear 
to revert to the original setting, or Center followed by Apply to center an array 
around 0;0. 

• Rotate Tab: Rotate the array by the specified angle. Enter the number and 
hit Apply, or hit Clear to return to the original setting. 



Guess 
Unknown 
Depth 

Hit this button to allow the system to ‘guess’ the depth of stations that did not 
report a depth sensor measurement, such as due to a defective depth sensor. 
The guessed depth will be the average depth of the stations before and after 
the one with a missing depth. If several stations in a row have a missing depth, 
a similar linear interpolation applies. 

 

View Menu 

Option Function 

Toggle 
Range 
Circles 

Toggles the range circles that provide a visual illustration of the software’s 
matching of a listening station to the intersections of the circles that describe the 
results of the range measurements to other stations. In theory, all range circles 
should intersect at the location of the station, but in practice measurement errors 
mean that the circles intersect in an area. A smaller intersect area indicates higher 
quality range measurements. To operate, select the listening station for which you 
want to see the circles in the array survey window, and toggle the range circles 
on. 

2.4. Mobile Menu 

The Mobile menu is pleasantly brief. The only options are clearing the position track in order to 
‘clean’ your screen, and the choice of pinger Position Estimation Filter settings. 

Option Function 

Position 
Estimation 
Filter → 

Settings→change different settings to filter out pings that show up in 
random/far-out locations. Position filtering is important to obtain a clean track. 
Refer to the Operator’s Manual for details. 

Clear Track Clears the track that the pinger has made so far 

Table 4: Mobile Drop-Down Menu 



 

Figure 4: Mobile Drop-Down Screen Shot 

2.5. Setup Menu 

The Setup menu is used to update the listening station firmware, set Acoustic Channel Definitions 
for pinger detection, and do other tasks. These functions are essential to tracking operations and as 
such are described in the Operator’s Manual. Here is a list of all options. 

Option Function 

Input/Output 
Connections 

Specify the COM port through which the STM - 100 connects to the array, a 
COM port to be used to export tracking data to other systems in real-time, 
and COM ports to import and export other sensory information or data types 
related to the tracking operations. 

Acoustic 
Channel 
Definitions 

The acoustic channels must be defined to match the pinger transmit 
parameters in order to track a pinger. 

Sound Speed Provides three means to estimate the sound speed: A constant speed, a 
constant temperature and salinity which is used to compute a depth 
dependent speed of sound, and input of a CTD (conductivity and 
temperature vs. depth) profile used to estimate sound speed at any depth. 

Update 
Firmware 

Update new firmware or re-install old firmware to te listening stations and 
the STM -100 junction box. 

Table 5: Setup Drop-Down Menu 



 

Figure 5: Setup Drop-Down Screen Shot 

3. File Formats 
RangeNav™ stores the full tracking record in a text file with a .trk extension. In addition, select data 
such as times of arrival can also be stored in log files, which are text files with a .log extension. 
These files are available for analysis of your tracking data using your own software tools. Figure 6 
shows a portion of a .trk file as it appears in Notepad. 

 

Figure 6: How To Read Array Survey Data 

Use the following examples to interpret the .log files. 



 

Figure 7: Signal Envelope .txt File 

In the signal envelope log, you only see two different items for each listening station. You first see 
the time “hours:minutes:seconds” with time to a resolution of 0.001 seconds. Then you see the 
signal strength itself. On the relative scale, scale 0 is the weakest and 1 is the maximum signal 
strength. The top line or the log provides the interpretation and station serial number sequence. 

 

Figure 8: Power Array .txt File 

This is quite easy to read as well. The first column is the time; the second and third correspond to 
the phase current (Ampere) and neutral current (Ampere) respectively. The next columns are the 



supply rail voltages measured at the individual listening stations. The first line provides the 
interpretation and list of listening station serial numbers. 

Other log files may be added in future software versions. If not listed here, refer to the first line of a 
log file as the key for interpretation. 

4. DiveBase RangeNav™ Computer Requirements 
● At least 1GB of free hard drive space 
● At least 512 MByte of RAM 
● Supported & Tested Operating Systems: 

○ Windows XP Service Pack 2 
○ Newer version of Windows will be tested as they become available and reach 

a reasonable state of maturity (target: 1 year). Please inquire with Desert Star 
Systems. 

○ Older versions of Windows including Windows XP (no service pack), Windows 
2000 etc. may work but are not tested by Desert Star Systems. 

Caution about using old & overloaded computers 

Desert Star’s experience has shown that the reliability of Windows machines declines as more 
application software is installed, or as they progress in age. These problems are often very hard to 
diagnose. We recommend that a dedicated surface station computer with a fresh Windows 
installation is used for RangeNav™ operations in order to maintain maximum reliability. 

While Desert Star does offer tech support to get RangeNav™ running on your old jalopy, we will 
most definitely charge for it and it will probably cost more than just buying a new machine ;) 
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1. Introduction to the STM-100 Surface Station Junction 
Box 
The STM-100 surface station junction box is designed to use with the RangeNav™ system for 
underwater tracking. It serves as the junction between the PC and the RPD cable which supplies the 
array. Its main job is generation and relay of electric power for the array, power monitoring functions 
and the relay of data between the array and the PC. The STM-100 also includes a GPS timing signal 
input, through which the entire array can optionally be synchronized to GPS time. This GPS time 
synchronization is an option used for geo-referencing the location of the listening stations. The 
connection between the STM-100 and the PC is via a USB port. The STM-100 links to the upstream 
end of the acoustic array through a six-pin connector, which accepts the standard underwater 
mateable connector of a RPD cable section. 

Not only is the STM-100 durable, it is also splash proof and very simple to master. With that said, it 
is not intended to be used as an umbrella. The STM-100 is factory configured for 440VAC or 
880VAC operation, 50/60Hz. 

 

Figure 1: STM-100 with controls: status light, fuse, power switch, power light 

2. Unpacking The Surface Station 
Please ensure that your STM-100 shipment contains these components. 

STM-100 Component List 

● STM-100 surface station 



● AC Power Cable 

Table 1: Component List 

The surface station requires that you have a PC operating on, at least, Window XP and the 
RangeNav software. These items are not a part of the station itself, and must be purchased 
separately. 

Please contact Desert Star Systems immediately if you are missing any components. 

3. Surface Station Installation And Activation 
Connections 

STM-100 installation is straightforward: Connect the station to AC power (110VAC or 220VAC as 
factory configured and indicated on the label), connect to the array via the Data/Power cable 
connector and connect to the PC via the USB port. For GPS timing synchronization (optional, refer 
to the RangeNav™ Operator’s Manual) connect the GPS receiver using a cable that Desert Star will 
custom manufacture for your GPS receiver. 

Activation 

After that, start the RangeNav™ software on the PC, select the correct COMM port (in the hardware 
manager, it’s designation will be a Sealink device), flip the power switch on the STM-100 and the 
system ready to go. Check the status and power light to make sure everything is in working order. 
Failure of the red power light to glow indicates no power or a blown fuse. Check and correct. The 
green status LED should emit a blink pattern. If that doesn’t happen, then the STM-100 electronics 
has not booted or is not working. In that case, switch the STM-100 power switch OFF, wait 15 
seconds and then switch it ON again. 

3.1. Installing And Configuring Surface Station Software 

DiveBase RangeNav™ Software_ 

The STM-100 surface station junction box works in conjunction with a PC running the ‘DiveBase 
RangeNav™’ software (also referred to as simply the RangeNav™ software). This software is 
normally installed by Desert Star Systems on the PC shipped with your RangeNav™ system. If you 
are using your own PC, install the software using the DiveBase RangeNav™ install disk and 
following standard Windows install procedures. 

STM-100 Firmware Installation 



The STM-100 itself contains firmware that is stored on its internal FLASH memory. Desert Star will 
update that firmware on occasion or to provide custom capabilities for your system. New firmware is 
downloaded to he STM-100 along with the entire connected array through a function in the DiveBase 
RangeNav™ software. Refer to the RangeNav™ Operator’s Manual for details. 

STM-100 Configuration 

The STM-100 operations are fully controlled by the PC through the DiveBase RangeNav™ software. 
So, operation of the device is limited simply to operating the ON/OFF switch. 

4. Connectors, Indicators And Controls 
The following tables and figures explain the STM-100 switch and connector functions. 

Connector Function 

A/C A/C power terminal for STM-100 operation. Factory configured and labeled 
for either 110VAC or 220VAC input voltage. 50/60 Hz. 

Array 
Data/Power 
Cable 
Connector 

Use to connect the upstream end of the listening station array to the 
STM-100. 

USB 
Connector 

The STM-100 connects to the PC via this port. 

GPS Time 
Signal 
Connector 

Optional GPS time signal input. Used for one method of geo-referenced 
surveying of the array. 

Power Switch Flip this switch ON to activate the STM-100. Keep it OFF for at least 15 
seconds to re-start the STM-100. 

Status LED 
(Green) 

Indicates operation of the STM-100 electronics. This indicator should emit 
one short blink once per second. Switch the STM-100 OFF, wait 15 seconds 
and switch ON again if the blinking does not occur. 



Power 
Indicator 
(Red) 

This indicator will light when AC power is connected. Check the AC outlet, 
the power cable and the STM-100 fuse if this indicator does not light. 

Fuse Knob Remove to replace the fuse. Fuse rating is 5 Ampere for 110VAC operation 
and 2.5 Ampere for 220VAC operation. 

Table 2: Connector Functions 

 

Figure 2: STM-100 Front Panel Connectors 

 

Figure 3: Data/Power Cable Adapter 

 



Figure 4: GPS Time Signal port 

 

Figure 5: STM-100 Power Inlet (30Ampere Marine Style) 

5. Maintaining The Surface Station 
The STM-100 is virtually maintenance free. Always make sure that the connectors remain free of 
debris and use a dry or somewhat damp cloth to remove dust. With the STM-100 panel closed, the 
station is rather water resistant and should operate fine even in ongoing rain. With the panel open, 
water resistane is more limited and any standing water should be mopped up at once. 

If the station should come in contact with significant quantities of salt water (such as it gets 
completely swamped by a wave), you have some chance of rescuing it by instantly removing it from 
the power source, rinsing it thoroughly with fresh water and shaking it dry. 

6. Model STM-100 Specifications & Order Numbers 

Size: 49cm L x 19cm W x 36cm H 

Housed in a rugged, splash-proof carrying case 

Weight: 16kg 

Operating 
temperature: 

0-50 degrees Celsius 



Data I/O: Connected and controlled via USB port from PC 

RS-485 interface to the listening station array 

GPS Time Signal port (3V TTL, 5V TTL or short to ground – open 
collector) 

Status 
Indicators: 

Power indicator on main panel (red) 

Processor system status LED on main panel (green) 

External 
power input: 

Factory configured for 110VAC or 220VAC operation, 50/60 Hz 

WARNING: Do not operate at voltage other than indicated on the 
STM-100 label. Wrong voltage may damage equipment. 

Power to 
array: 

Factory configured for 440VAC or 880VAC nominal. 

WARNING: The voltage configuration of the RBS listening stations and the 
STM-100 must match. Mismatch may result in equipment damage. 

Array power 
monitoring: 

STM-100 monitors current on phase and neutral line to array 

Listening stations report AC voltage at each node 

Ground Fault 
Interruptor: 

STM-100 cuts power to the array when the mismatch between the phase 
and neutral conductor exceeds a specified limit. 

Note: all specifications are subject to change without notice 

Order Numbers STM-100: Surface Station Junction Box 

CBL00046: U.S. Power Cord for STM-100 (110V Single-Phase power plug to 30Ampere Marine 
Plug) 



 

ITEM NO. PartNo DESCRIPTION QTY. 

1 HOU01440 STM-100-PANNEL 1 

2 CON00380 3-Pin BULKHEAD 3/4“ Post, Brass 1 

3 CAS00003 PANNEL RING KIT STM-10 1 

4 CAS00056 STM-100 Internal Foam 1 

5 XFM00320 Harsh Environmen 240/480V Input 4 

6 CON00517 50A 125/250V Non-Metallic Inlet 1 



7 EM100PCA EM100 Listening Station Module 1 

8 EMBU100 EMBU100 PCB Assembly 1 

9 EMBD100 EMBD100 PCB Assembly 1 

10 HOU01391 RBS-100 Housing 1 

11 CON00302 5-PIN-CONN 1 

12 CON00345 6-PIN, 3/4” POST, FEMALE, BRASS 1 

13 ORI00006 O-Ring 2-014 E515 3 

14 HDW00245 HDW-SS-7/16-20-LG HEX MACH NUT 3 

15 CAS00002 CASE PELICAN STM-10 NO RING 1 

16 LED00314 LED-STM-10 1 

18 LED00326 Red Indicator Light-Neon 105-125V 1 

19 FUS00261 Screw-Cap Panel-Mount Fuse Holder 1 

21 SWT00320 D.P.D.T. ON-OFF-ON Toggle Switch 1 

22 HDW00617 8-32 5/8“ Button Head Socket Cap 14 

23 ORI00056 O-Ring 2-104 14 
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1. Introduction Of RPD-275/550/1100 
The RPD-275/550/1100 (RangeNav Power & Data cable) is designed for use with the RangeNav™ 
system, where it serves to interconnect the RBS-100 listening stations. The RPD comes available in 
3 different sizes: 275 meters, 550 meters, and 1100 meters. This includes 10% slack for nominal 
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station spacing of 250m, 500m, and 1000m. The cable sections weigh 85lbs, 170lbs, 340lbs each 
respectively. 

The copper based cable carries both data and power. Two twisted wire pairs are support two RS- 
485 formatted independent data channels. Controlled by the systems firmware, one pair may carry 
data in the downstream and one in the upstream direction, or a single pair may switch between the 
downstream and upstream direction to route data around a failure affecting the other pair. The 
system’s supply voltage is carried by the final two conductors. The cable supply voltage rating is 900 
VAC and 50/60 Hz power is used. The cables polyurethane jacket provides strong abrasion and cut 
resistance. A Kevlar braid and additional strength member yield a working load of 500lb and a 
breaking strength of 2000lb. The cable sections are equipped with a “chinese-finger” strain relief 
system that protects its connectors and the listening stations. . When pulling on each end it tightens 
up, and when released it releases the pressure. Through the cable’s clear jacket you can visibly see 
the water swelling tape whose job it is to slow down water intrusion in case of damage. 

 

Figure 1: deployment, shore section, spools of cable, and yet another caught fish hook 

2. Unpacking 
Please ensure that your shipment does contain these components. 

RPD-275/550/1100 Component List 

● Section of desired cable (ie-275m, 550m, 1100m) 

Table 1: Components List 



If a shipment is incomplete, please immediately contact Desert Star Systems. If you are missing any 
components required for system operation, obtain these components before proceeding. 

3. Connector Termination 
The RPD cable sections are terminated with SEACON micro series six-pin underwater mateable 
connectors. The male MCIL6M connector is used on the upstream end, and the female MCIL6F 
version on the power carrying downstream end. The pin assignment is as follows. 

 

Figure 2: Data/Power Cable Connectors and Adapters 

3. Preparations For Operation 
Follow these steps to get the cable ready for operation. 

● Depending on your method of deployment, gather the cable and ready it (mount it on 
spool, etc.). Keep in mind that one section is needed for each listening station. 

● Connect the first listening station. Apply a thin film of silicone grease before mating the 
connector, mate all the way and ensure the locking sleeve is threaded to a full stop. 

● Securely fasten the cable to the strong back using cable ties. This is essential to prevent 
failure of the connector termination due to repeated flexing at the connector. 

● Link the loop of the strain relief system to the strong back using a stainless steel shackle. 
● Link the listening station to the next cable section using the same method. 
● Attach the hydrophone and float to the listening station. 
● Lead the boat in the desired direction, letting the cable feed into the water over the stern. 
● Follow this process until all the listening stations are in the water. 
● The upstream end of the first listening station must be connected to the STM-100 junction 

box. 



 

Figure 3: The inside wiring of the CABLE 

4. RPD-275/550/1100 Specifications & Order Numbers 

Size: 250m length 

550m length 

1100m length 

Weight in air: 85lbs 

170lbs 

340lbs 

Weight in 
water: 

All cable sections are negative buoyant 



Depth Rating: Full ocean depth 

Connectors: SEACON MCIL6M (upstream end) and MCIL6F (downstream end), 
underwater mateable, secured by locking sleeves. 

  

Working load: 500lbs max. 

Breaking 
strength: 

2000lbs typical 

Min. bend 
radius: 

15 cm (6”) 

Strain relief: “Chinese finger” system, 2500lbs rating 

Design: Polyurethane jacket, Kevlar braid and strength members, water swelling 
tape, conductors with Teflon insulation. 

  

Operating 
temp.: 

-20 - 70 degrees Celsius 

Data 
conductors: 

Two twisted, shielded pairs. 22AWG. For RS-485 or other signaling 
standards. 

Power 
conductor: 

Two conductors (phase and neutral), 16 AWG 

Max. supply 
voltage: 

1000 VAC RMS 

Note: all specifications are subject to change without notice 



 

Hybrid Round Cable 7 Dec. 2004 

EHRK 34594 Rev. 1 

Pos 1 

2 pairs of insulated wires 0.38 mm² / AWG 22 



conductor (19 x 0.16 mm) tin plated copper 

insulation TPE 

colour brown/red, orange/yellow 

drain wire 0.25 mm² / AWG 24 

conductor (19 x 0.127mm) tin plated copper 

screen  

material aluminized polyesterfoil; foil side in optical coverage 100% 

binder polyester 

 

Pos 2 

2 insulated wire 1.23 mm² / AWG 16 

conductor (19 x 0.29 mm) tin plated copper 

insulation TPE 

colour black, white 

 

Pos 3 

fillers water swelling; as required for roundness 

 



Pos 4 

binder water swelling 

 

Pos 5 

braided support mesh  

material kevlar 

working strength greater than 3200 N (500 lbf) 

break strength approx. 11000 N (2500 lbf) 

 

Pos 6 

outer jacket  

material polyurethane 

wall thickness 1.0 mm (0.040”) 

colour clear printed with black characters 

 custom print -TBD 

Hybrid Round Cable 7 Dec. 2004 

EHRK 34594 Rev. 1 

Technical Data: 



 Pos 2 Pos 1 

operating voltage: 1000 V 600 V 

test voltage conductor/conductor: 5000 V/DC 3000 V/DC 

test voltage conductor/shield: 3000 V/DC 2500 V/DC 

operating temperature: -50° C to +90° C [-58°F to +194°F] 

weight 107 g/m = 72 lb/1000ft  

pair nominal impedance: 55 Ohms  

Bending radius: 

fixed installation: 2 x diameter 

minimum bending radius at continuous flex: 5 x diameter 

best bending radius at continuous flex: 10 x diameter 

CABLE IS USED IN LENGTHS OF: 275 metres 

REVIEWED AND APPROVED: 

COMPANY NAME: Deesert Star Systems LLC 

SIGNATURE: 

NAME: Marco Flagg 

DATE: 07DEC04 
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1. Introduction To The RBS-100/101 
The RBS-100/101 are broadband listening stations designed for use with the RangeNav system. 
They both gather ping information and send that to the surface station via the RS-485 copper based 
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RPD cable. The difference between the two is that the RBS-101 also has the ability to record raw 
acoustic data on an internal CF FLASH card (1 GB standard and 8 GB optional). Stored acoustic 
data can then be uploaded to the PC as bandwidth is available. Though you do have the capability 
to send the raw acoustic data straight to the PC, these data are treated as lower priority by the 
system (to maintain tracking capabilities at all times) and uninterrupted real-time transmissions may 
not be possible. 

The RBS-100/102 listening stations are linked in a daisy-chain fashion, with up to one hundred 
stations per chain. The maximum supported chain length is twenty nautical miles if they are spaced 
in 1km intervals. In the future, the support of multiple chains by RangeNav™ will extend coverage up 
to a 20nm x 20nm. 

The listening stations receive acoustic signals from the pingers of the targets to be tracked through 
the broadband hydrophone. A combined hydrophone and transmit transducer assembly is attached 
to the to the listening stations for this purpose. The attachment is by a 1.2m cable, and a flotation 
sphere allows the transducer to float above the listening station on the sea floor for better reception 
of acoustic signals. The listening stations filter and process all acoustic data using their powerful 
on-board digital signal processor (DSP). Processing is done per instructions from the surface station, 
and the stations need only report brief ‘ping descriptor packages’ via the cabled link to the surface. 
On-board signal processing greatly reduces the amount of data that needs to be transmitted to the 
surface station, thus allowing RangeNav™ to rely on inexpensive and rugged copper cables as 
compared to the expensive fiber & copper technology used by many tracking ranges. At the same 
time, the on-station processing greatly reduces the performance requirements of the surface station, 
allowing a powerful PC to perform that job. Overall, a RangeNav™ system with its distributed and 
DSP powered listening stations can be considered a networked supercomputer for acoustic signal 
processing under the sea. 

The stations also include an array self-survey capability. They simply use their acoustic transmitter 
and transducer, which operate at 16kHz-24kHz, to measure distances among station pairs. Each 
station is also equipped with a pressure sensor of 500 PSIA, supporting their 300m depth rating 
while reading station depth with an accuracy of 0.3m. The stations run at 50/60Hz AC power and are 
factory configured along with the STM-100 surface station junction box to operate at 880VAC or 
440VAC. The lower voltage (440VAC) is the safest solution when tracking targets in an area where 
human contact is a possibility. The 880VAC option provides greater range. 

2. Unpacking 
Please ensure that your shipment does contain these components. 

RBS-100/101 Component List 

● RBS-100 or RBS-101 Remote Baseline Station 
● Hydrophone assembly with cable 
● Metal strong-back 



● Two stainless shackles for securing the strain relief system 
● Two 5lb lead weights 
● Two rubber pieces (works as washer between RBS and strong-back) 
● Two hose clamps 
● One trawl float, providing 3.8lb flotation for the hydrophone assembly. 

Table 1: Components List 

If a shipment is incomplete, please immediately contact Desert Star Systems. If you are missing any 
components required for system operation, obtain these components before proceeding. 

 

Figure 1: Listening Station and STM-100 with Hydrophones 

3. Preparations For Operation 
Follow these steps to get the listening station ready for operation. 

● Unpack the baseline station and make sure you've got all the parts. 
● Run a system test on the stations prior to deployment by wiring them up and operating on 

shore. 
● Mount the metal strong-back, fasteners, and weights. 
● Attach the Hydrophone with its cable and trawl float. 
● Activate and deploy the baseline station. 



Refer to the RangeNav™ Operator’s Manual for detailed instructions of connecting the listening 
stations. 

 

Figure 2: Listening station components 

3.1 Configuring and Operating The Listening Stations 

The listening stations are configured by the surface station to perform specific operations such as 
the detection and decoding of pinger signals or array survey functions. The surface station also 
directs the power-up sequence and guides firmware update downloads to the array. Please refer to 
the RangeNav™ Operator’s Manual for details. 

4. RBS-100/RBS-101 Connectors 
The listening stations are equipped with three connectors: 

1. The upstream data & power connector links the listening station via a section of RPD 
cable to the next station upstream, i.e. closer to the surface station. This connector 
receives power and it is therefore (for electric hazard safety purposes) male. The 
connector has six pins and is a SEACON model MCBH6M. 



2. The downstream data & power connector links the listening station via a section of RPD 
cable to the next station downstream, i.e. closer to the end of the chain. This connector 
transmits power and it is therefore (for electric hazard safety purposes) female. The 
connector has six pins and is a SEACON model MCBH6F. 

3. The hydrophone connector links the listening station via a 1.2m cable to to its combined 
hydrophone and transmit transducer unit. This connector carries the supply voltage for 
the hydrophone pre-amplifier, the hydrophone signal and the transmit sonar transducer 
driver signal. The female connector has four pins and is a SEACON model MCBH4F. 

The following diagrams provide the pin assignment of the connectors. 

 

Figure 3: Data/Power Cable Connectors 

 

Figure 4: Hydrophone Connector 

5. Listening Station Maintenance 
Your RBS-100/101 is a rugged instrument that requires only little maintenance. However, please do 
observe the following points to ensure long and proper operation. 

● Rinse the instrument with fresh water after each deployment. Pay special attention to the 
area around the connectors and transducers on the end caps. The transducers, 
connectors, screws, mounting ring, and other hardware are brass and stainless steel. 
Even though the housing is of Derlin plastic, some corrosion may still occur at the points 
where the metal meets the plastic if the station is not cared for properly. This corrosion 



can be minimized through proper rinsing and drying. Corrosion around this area will rarely 
be severe enough to affect operation. It may however be a cosmetic consideration. 

● Make sure that debris does not block the hole in the depth sensor on the connector end 
cap. If this should happen, rinse the sensor with a strong stream of water in order to 
dislodge the debris. Do not dry to pick it out with a pin or something with a sharp end, you 
could damage the sensor. 

● The listening station’s housing is sealed with a number of O-rings. The O-ring rubber has 
a limited lifetime. We recommend that you return your listening station to Desert 
Star Systems every three years for service. 

6. RBS-100/101 Specifications 

Size: 425 mm L x 75 mm D (20.75” L x 3” D) 

Weight: Weight of the RBS-100/101 2.04 kg (on land) -.27 kg (in water) 

Weight of supplied equipment (fasteners, hydrophone, cable, 
strong-back): 2.353 kg (on land) .379kg (in water) 

Depth Rating: 300 meters (1000 feet) 

Operating 
temperature: 

0-70 degrees Celsius 

Power Supply: Power supplied via RPD series data/power cable 

Factory configured for 440VAC or 880VAC operation, 50/60 Hz. Approx. 
6 Watt consumption 

Data I/O: Four independent RS-485 data channels, each operating at up to 900 
kbit/sec. 

· Two data channels on the upstream end of the station 

· Two data channels on the downstream end of the station 

Status Indicator: Via surface station PC 



Depth Sensor: 500 PSIA, 0.1% FSO accuracy (300m max. depth, 0.3m accuracy) 

Processors: Texas Instruments MSP430F149 microcontroller for supervisory 
functions 

Texas Instruments TMS320C6203 DSP for signal processing (2 Billion 
Operations per Second max.) 

Data Storage: RBS-101 ONLY—1GB CF Flash card (8GB option) for raw acoustic data 
intermediate storage 

Sonar 
transmitter: 

For array self-survey purposes. 192 dB acoustic power, 16-24 kHz 

Sonar receiver: Broadband, 100 Hz – 80 kHz 

Sonar 
transducers: 

Combined hydrophone & transmit transducer assembly connected via 
1.2m cable 

Sonar range: Designed for station spacing of 250m, 500m or 1000m depending on 
acoustic conditions and water depth. 

Sonar 
demodulation: 

Software defined demodulator. Currently supported is demodulation of 
signals from Desert Star’s Frequency-hopping, pulse position depth 
encoded pingers. 

Sonar 
navigation: 

Range measurement repeatability approx. 0.15m RMS 

Note: all specifications are subject to change without notice 



 

To test your listening station’s durability, we executed various tests such as dropping them from high elevations. To 

preserve your stations, DO NOT repeat those tests yourself. 



 

ITEM NO. PartNo DESCRIPTION QTY. 

1 HOU01393 RBS-100 Downstream Endcap 1 

2 EMBD100 EMBD-100 PCB Assembly 1 

4 HDW00224 HDW-NYLON-.375“ (3/8”)- Spacer 8 

5 SSP1 Small Smart Pressure Transducer 1 

8 CON00345 6-PIN, 3/4“ POST, FEMALE, BRASS 1 

9 ORI00006 O-Ring 2-014 E515 3 

10 HDW00345 HDW-SS-4-40-5/8-Socket Cap 8 



11 ORI00008 O-Ring 2-139 E515 2 

12 HOU01392 RBS-100 Upstream Endcap 1 

13 HOU01394 RBS-100 Transformer Cradle 2 

14 EMBU100 EMBU-100 PCB Assembly 1 

15 HDW00225 HDW-Nylon-(1/2”)-SPACER #4 Thread 4 

16 XFTLP100 TLP-100 XFM 8-16 kHz 5P 550S 1 

17 HDW00576 4-40-1 3/4 Socket Cap SS 4 

18 CON00346 6-PIN 3/4“ Post, Male, Brass 1 

19 CON00482 4-Pin BULKHEAD 3/4” Post, Brass 1 

20 EM100PCA EM100 Listening Station Module 1 

21 HOU01395 RBS-100 PCB Support Ring Top Side 2 

22 HOU01396 RBS-100 PCB Support Ring Bottom S. 3 

23 HDW00295 HDW-SS-4-40-1/2-Socket Cap 6 

24 HDW00298 4-40 Nylon Locknut SS 2 

25 HOU01391 RBS-100 Housing 1 

26 HDW00186 HDW-SS-4-40-3/4-SOCKET CAP 12 

27 HOU01412 HOU-EM100 StrongBack 1 



28 WHT00000 5LB Hard Dive Weight 2 

29 HDW00619 Hose Clamp 2- 13/16“ to 3-3/4” 2 

30 HDW00620 Oval Threaded Connector 3/8 Dia 2 
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1. Introduction to the TLP-100/101/102 
The TLP-100/101/102 (Target Locating Pinger) are depth encoded pingers designed primarily for 
use with the RangeNav™ underwater tracking range. They are suitable for tracking targets such as 
submarines, torpedoes, AUV/UUV and ROV. The three pingers use the same operating procedures 
and are in many aspects identical. Other than visible differences, the main distinction is that each 
operates within a different frequency range, thus offering more channels for multiple target tracking 
and suitable selections for both long and short distance operations. The TLP-100 operates in the 
lowest frequency range (8-16 kHz), which allows its signal to travel the farthest. Yet at 475mm L x 
127mm D and 7.4 kg in air, it is also the largest and heaviest of the family. The TLP-101 and 
TLP-102 operate at 16-24kHz and 34-42kHz respectively. They use the same housing measuring 
300mm L x 82.5mm D, and have a weight of approximately 1.8 kg. All pingers offer a ‘high power’ 
transmit mode of 192 dB, and can also be operated at regular power of about 182 dB. Battery life is 
12 hours in high power mode at one transmission per second, and exceeds 24 hours in regular 
power mode. All pingers have internal, re-chargeable batteries which charge in about 12 hours. The 
three pingers are equipped with precision depth sensors. The depth sensors offer a resolution of 0.3 
meters and read correctly up to the pinger family’s operational depth of 300m. The pingers are 
equipped with a rugged, waterproof on and off power switch. The configuration and installation of 
each pinger is quite easy and can be accomplished onsite or offsite. Simply mount the pinger on the 
target in a vertical orientation using suitable brackets or clamps. 

TLP-100/101/102 Characteristics 

● Target Locating Pinger, designed to track targets from a variety of sizes and depths. 
● Straightforward installation and configuration in minutes. 
● Rechargeable batteries provide the luxury of less maintenance resulting in more field 

time. 
● Simple yet rugged design allows for maximum uses yet minimizing installation and 

configuration time. 
● Frequency specific pingers allow for accurate measurements of up to eight targets. 
● GPS time signal availability provides the opportunity to coordinate land and sea targets 

together. 
● Equipped with a precision 500 PSIA depth sensor, which has an accuracy of 0.5 PSI, 

allows for better pinpoint accuracy. 

Figure 1 shows the TLP-100/101/102 (in order 102-100-101). The sonar transducer is located 
toward the bottom of the pinger, protected by a cage. The depth sensor is located on the top portion 
of the pinger. Also located on top, is the power switch and a two-color status LED. The pingers were 
designed so that all controls are readily available. 



 

Figure 1: TLP-100/101/102 

2. Unpacking 
Please ensure that your shipment does contain these components. 

TLP-100/101/102 Component List 

● Target Locating Pinger (TLP-100/101/102) 
● Multi-function adapter plug 

Accessory Kit (sold separately) 

● MCU-5 (multiple charging unit with 5 adapters. This unit also has a built in USB plug 
(hooks directly to the PC with only a USB cable) suitable for configuration and firmware 
download. 

If a shipment is incomplete, please contact Desert Star Systems. 

In order to operate your TLP-100/101/102 effectively you will also need the other components within 
RangeNav as well as the RangeNav software and a PC running Windows XP or a later version. 

3. Preparations For Operation 



Follow these simple steps to get your target locating pinger ready for operation. 

Preparations For Operation 

● Unpack the pinger and make sure you have all the components. 
● Configure and test the pinger using the provided software. 
● Fully charge the pinger prior to each and every deployment to insure full battery 

availability. 
● Mount the pinger on the target by following the instructions. 
● Switch the pinger on prior to releasing or launching the target. 

CAUTION: 

These pingers support high transmit power. Other than for brief tests, make sure to place the stations in water when pinging in 

order to reduce stress on the sonar transducer. When operated in air, this stress can eventually crack or otherwise destroy the 

sonar transducer. 

3.1 Charging The Battery 

Nickel Cadmium rechargeable batteries power the TLP-100/101/102. The batteries of the pinger are 
recharged using a trickle charge over 12 hours. This method, while slow, assures that the batteries 
are at 100% charge each and every time. We recommend charging the battery prior to each use. If 
the pinger sits unused for an extended period of time, the battery will eventually (after a few weeks) 
be exhausted due to the standby current. Charging the battery prior to each deployment will prevent 
this.\ 

When first receiving your pingers, we recommend that you condition the battery by charging the 
battery, operating the pinger until discharged (place in water, see CAUTION above) and then 
repeating that cycle 3-5 times. 



 

Figure 2: TLP-100/101/102 Top Profile 

To charge the battery, follow these instructions. 

1. Wipe the multi-function connector as well as the adapter free of debris. 
2. Connect the charger cable to the multi-function connector on the pinger. 
3. The green LED in the sensor emits a flash once every second signaling that it’s charging. 
4. When the pinger is fully charged the Green LED will emit a solid glow. The approximate 

charging time is 12 hours. The approximate battery life of a pinger is 12 hours in 
high-power mode, and more than 24 hours in regular transmit power mode. 

3.2 Pinger Activation 

A power switch is used to turn the TLP-100/101/102 on. It is a very simple method of just turning the 
power switch until the ON position on the switch meets the mark on the housing. At this point the 
Red LED will start to flash once every second, unless the battery is low in which case you will see 
rapid flashing. Do not leave the pinger on and pinging while out of water for an extended period of 
time. Doing so will eventually damage the sonar transducer. 

3.3 Status LED Blink Patterns 

The TLP-100/101/102 uses a two color (red/green) status LED. Here is a guide to the blink patterns. 

Blink Pattern Interpretation 

RED rapid 
blinking 

The battery is low. Recharge the pinger. 



RED single 
blink once per 
second 

The transponder is operating normally and is pinging. 

RED triple 
blink 

Hardware error. This blink patterns currently indicates a depth reading too 
far from zero. Causes could be a defective depth sensor, or you switched 
the transponder ON while submerged. Transponder functions will still work, 
although the depth reporting may be faulty. 

GREEN single 
blink once per 
second 

The pinger is charging. 

GREEN 
continuously 
ON 

Battery charging is completed. 

Table 1: Status LED Blink Patterns 

3.4 Configuring and Testing the TLP-100/101/102 

The TLP-100/101/102 are configured from a PC through a serial data interface. When using the 
MCU-5 multi-station charger and configuration box, connect the pinger to the MCU-5 connector 
marked COM, and connect the USB port of the MCU-5 to the PC. Then, enter HyperTerm (a 
standard PC utility), select the correct COMM port on the PC and configure for 4800 baud, 8 data 
bits, no parity, one stop bit. 

Now, switch the pinger on. You will see this print out: 



 

Figure 3: Print-out after power up, followed by #st  user entry to initiate self tests 

At this point you can enter #c  to configure the printer, #st to initiate some self tests or choose a few 
other self-explanatory options. The primary configuration parameters of interest are the pinger’s 
operating frequencies (channels) as well as the length of the pings. For single target tracking, always 
use channel 1 and set the frequency band associated with the pinger model: LF for the TLP-100, MF 
for the TLP-101 and HF for the TLP-102. The length of each ping for optimized tracking with 
RangeNav should be set to 1 ms, the default value. 

The configuration menu also includes diagnostic capabilities, which are engaged through the #ST 
(self test) command. 

The tables list the available self tests, configuration functions and ping channel frequency 
assignments. 

Self Test Menu 

1. LED You are able to toggle the red and the green LED on and off to check to 
make sure they both emit the correct glow. 



2. High 
Power 
Test 

Your are able to make sure that your boost regulator is in proper working 
condition. 

3. Ping You are able to select the frequency channel and test the ping’s frequency in 
relation to that channel. You can tweak the frequency up or down one kHz, 
too. 

4. Depth 
Sensor 

You are able to see at which depth and temperature the pinger is reading at 
the moment. Because you will be at a different elevation, there is no 
standard depth to watch for. 

5. Charge You are able to read the voltage that your power supply is producing to 
make sure that it is producing the proper voltage. 

6. Knob You are able to test the on and off power switch by simply rotating it toward 
the built-in groove. 

? This 
Menu 

Brings up the current menu. 

X exit Exits the current menu. 

Table 2: Self-Test Menu & Screen Shot 



 

Configuration Test Menu 

Symbol Option Within 
Configuration 
Test Menu 

Its Purpose 

1. Set LF Band 
(8-16 kHz) 

1. Always goes with TLP100 

2. Set MF Band 
(16-24 kHz) 

2. Always goes with TLP101 

3. Set HF Band 
(34-42 kHz) 

3. Always goes with TLP102 

4. Set Channel 
(1-8) 

For single target tracking, use channel 1 



5. Set Interval 
Between 
Transmissions 
(mS) 

This allows you to change the time between pings. 

6. Set Ping 
Lengths (mS) 

This allows you to change the length of the pings. Though if 
running specialty ping filters on the listening stations you may 
have to change the ping lengths to adapt; meanwhile, leave it 
at 1mS. 

7. Set Ping 
Frequency 
Mode 

This allows you to switch from Depth Coded Mode to single 
ping (frequency) Mode where your application does not need 
to know the depth of the target. 

8. Set Depth 
Coded Mode 

This is the default mode, which is used under normal 
operations; unless you do not need to know the depth of your 
target, use it. 

R Reset to Factory 
Defaults 

In case of changing the settings unknowingly, you can revert 
back to the factory settings with this. 

X Exit and Save 
Settings 

Exits the screen 

Table 3: Configuration Test Menu & Screen Shot 

 Low Frequency kHz Medium Frequency kHz High Frequency kHz 

Channel 1 8.4925 & 10.498 16.5289 & 18.5185 34.4828 & 36.3636 

Channel 2 9.5011 & 11.4943 17.4672 & 19.5122 35.3982 & 37.3832 

Channel 3 12.5000 & 14.4925 20.5128 & 22.4719 38.4615 & 40.404 

Channel 4 13.5135 & 15.5039 21.5054 & 23.5294 39.604 & 41.6667 

Channel 5 8.0000 & 10.0000 16.000 & 18.018 33.8983 & 36.036 



Channel 6 9.00901 & 10.9890 17.0213 & 18.9573 35.0877 & 37.037 

Channel 7 12.012 & 13.9860 20.000 & 21.978 38.0952 & 40.000 

Channel 8 12.987 & 14.9813 21.0526 & 22.9885 38.835 & 40.8163 

Note: Each ‘channel’ encompasses two frequencies, for the first and second ping respectively. The pingers transmit a two 

ping sequence to encode the depth. The time elapsed between the first and second ping is proportional to the depth. 

Table 4: Channel Frequency kHz 

3.5. Firmware Update 

 

FirmwareUpdate.exe 

The TLP firmware determines the behavior of the device. Follow this procedure to update the 
firmware. 

1. Link the pinger to a COM port of the PC via the MCU-5 charger and configuration box. 
2. Start the FirmwareUpdate  utility and select the COM port you are using. 
3. Switch the pinger ON. 
4. Hit the ‘Download New Application’ and select the new firmware file. Firmware files have 

the extension .vc and are supplied by Desert Star Systems. 
5. A progress bar appears during the download process. 



 

4. Pinger Mounting 
For best tracking performance, the pinger should be mounted along the bottom of the target. This 
ensures the best transmission of pings to the sea floor mounted listening stations. However, in many 
case mounting options will be restricted due to hydrodynamic considerations, available space etc. In 
these cases, other mounting options such as along the top are valid and may result in similar 
performance. 

In any case, the main considerations as far as RangeNav performance is concerned is to avoid 
‘sonar shadows’ and ensure proper alignment of the pinger’s sonar transducer beam pattern with the 
array of listening stations. It is helpful here to consider the sonar transducer to be similar to a cell 
phone antenna. Some placements will yield better results than others. 

● The sonar transducer beam pattern is strongest out the sides of the pinger (radial 
direction), but exhibits a dip along the length axis of the pinger. In order to most efficiently 
transmit energy to the listening stations, mount the pinger vertically. Mount it with the 
transducer facing up when on top of the vehicle, or the transducer facing down when 
mounted on the bottom of a vehicle. 

● The body of the target that the pinger is mounted on will cast a sonar shadow. This 
shadow may prevent ping energy from reaching listening stations that era effectively 
located ‘behind’ the target. This can impact tracking performance. Ideally, mount the 
pinger on the bottom of the target so that it has a ‘clear line of sight’ in all directions and 
to directly below. If not practical, mount it along the top with the sonar transducer facing 
up. Due to the sonar shadow, you may loose the benefit of listening stations located 



almost directly below, but there will probably be a sufficient numbers of listening station 
‘in sight’ out to the sides. 

Besides acoustics, consider issues such as mechanical stability, interference with other acoustic 
systems (the pingers will not receive interference, but they may disturb other systems), protection 
against impact during handling etc. The table provides some guidance. 

Guidelines For Mounting TLP-100/101/102 Mounting On A Target 

● The sonar transducer should not be shielded by any part of the target. It is ideal to mount 
the pinger near the bottom of the target, vertical with the transducer facing down, to 
obtain an unobstructed view of the listening stations. Use a placement that comes close 
to this ideal. 

● Keep the pinger away from moving parts for both hazard avoidance and because they 
can sometimes generate an acoustic shield due to cavitations and possibly other physical 
processes as well. 

● Maximize the space between the pinger’s sonar transducer and other sonar transducers 
on the target. Interference to other systems may result if transducers are spaced too 
closely. If using a scanning or imaging sonar, mount the pinger out of the beam pattern of 
that instrument. 

● Always mount the pinger vertically, typically with the transducer facing away from the 
target. 

● Use custom manufactured brackets, hose clamps or similar means to secure the pinger. 
Mount securely so that the drag of water will not move the pinger. 

● Consider impact areas. The pingers are quite rugged but they still prefer to be treated 
gently. 

5. The Multi-Function Connector 
The multi function connector is a SEACON model MCBH5F. This connector is used to wire the 
station to an umbilical (for remote power), to connect a battery charger, to configure the pinger via 
the PC or to supply a GPS timing signal for special applications. The connector must be terminated 
before the transponder is submerged to prevent corrosion. If the station is not connected to the 
umbilical, terminate it with the supplied dummy plug. 

For GPS time synchronized pinging, apply the GPS time signal to pin 5 and the ground return to pin 
1. The pinger is compatible with 3V or 5V TTL signals or an open collector (short to ground) signal. 
The pinger will transmit a fixed time following the rising or falling edge of the synchronization signal, 
depending on its configuration. 



 

Figure 5: Multi-Function Connector Pin Assignment 

6. TLP-100/101/102 Maintenance 
Your pinger is a rugged instrument that requires very little maintenance. However, please do 
observe the following points to ensure long and proper operation. 

Maintenance Instructions 

● Rinse pinger with fresh water after each deployment. 
● Make sure that the depth sensor access hole in the end cap of the housing does not get 

clogged. Rinse with fresh water after use to minimize corrosion of the metal sensor 
housing. 

● Wipe the plug area dry as well to get rid of the possibility of corrosion. 
● Charge the device before use and at least once every six months for battery maintenance 

purposes. 

7. TLP-100/101/102 Specifications 

Size: TLP-100 475mm L x 
127mm D 

18.7in L 
x 5in D 

TLP-101 300mm L x 
82.5mm D 

11.8in L 
x 3.25in 
D 

TLP-102 300mm L x 
82.5mm D 

11.8in L 
x 3.25in 
D 



    

Weight:  Weight on 
Land 

Weight 
in Water 

TLP-100 7.399 kg 3.979 kg 

TLP-101 1.984 kg .772 kg 

TLP-102 1.786 kg .574 kg 

    

Depth Rating: 300 meters max. working depth   

Operating 
temperature: 

0-50 degrees Celsius   

Configuration & 
control: 

Power Switch and multi-function connector   

Status 
Indicator: 

Dual color RED/GREEN status LED   

Sensors: Depth sensor for depths of 300 meters, with 
accuracy of .3 meters 

  

Sonar 
Transmitter: 

Frequency hopping, pulse-position coded. 
192dB transmit power in high power mode, 
approx. 182dB with regular power. 

  

Sonar 
Transducer: 

Near omni directional transducer mounted on 
end cap. 

  

Power supply: TLP-100 (9 Nickel 
Cadmium 

 



D-cell 
batteries) 

TLP-101/102 (8 Nickel 
Cadmium 
C-Cell 
batteries) 

 

Battery Life 
(approx.): 

TLP-100 12 HRS in high power mode, more 
than 24 hours in regular power mode 

 

TLP-101 12 HRS in high power mode, more 
than 24 hours in regular power mode 

  

TLP-102 12 HRS in high power mode, more 
than 24 hours in regular power mode 

  

Note: all specifications are subject to change without notice 



 

ITEM NO. PartNo DESCRIPTION QTY. 

1 HOU01314 PLATTS TLP-100 Housing 1 

2 HOU01211 RBS-2 Connector End Cap 1 

3 HOU01415 TLP-100 Battery Plate 2 

4 HOU01473 TLP-100 8KHz-16KHz Transducer Endcap 1 

5 TDC00024 8KHz-16KHz Oil Filled Sonar TDCR 1 

6 HDW00583 HDW-stand off-3/16D 1“L SS #4 TLP 8 



7 SSP1 Small Smart Pressure Transducer 1 

8 CON00302 5-PIN BULKHEAD, 1/2” POST, BRASS 1 

9 EM40PCA Module for TLP-10X Pingers 1 

10 HOU01219 RBS-2/2D Cage Posts 4 

11 HOU01213 RBS-2 Cage Ring 1 

15 HDW00174 HDW-SS-6LG-FLAT WASHER 1 

16 HDW00202 HDW-SS-6-32-1/4-BUTTON CAP 1 

17 HDW00188 HDW-6-32-3/8-SS-Socket Cap 1 

18 LBL00000 LBL-SPORT-TX-Knob 1 

19 HDW00342 HDW-10-24 1/2“ SS Socket Cap 4 

20 HDW00264 HDW-SS-4-40 18-8 1/4”L Flat Head 8 

21 BP-TLP-0 TLP-100 BP Ni-Cd 9 C-Cell 1 

22 EMBU100 EMBU-100 PCB Assembly 1 

23 HOU01407 TLP-101 Transformer Cradle 1 

24 HDW00342 HDW-10-24 1/2“ SS Socket Cap 6 

25 TLP100XF 8-16 kHz XFM 5P 550S 1 

26 HDW00582 HDW-stand off 3/16D 3/4L #4 SS TLP 8 



27 ORI00006 O-Ring 2-014 E515 1 

28 ORI00004 O-Ring 2-012 E515 1 

29 HDW00348 SS U-Bolt 5 5/8” for RBS-2 2 

30 HDW00324 SS-Nylon Lock Nut 1/2-13 6 

31 HDW00196 HDW-10-24 5/8“ SS Socket Cap 8 

32 ORI00035 O-Ring 2-241 E515 2 

 

TLP-101 Configuration 



ITEM NO. PartNo DESCRIPTION QTY. 

1 HOU01404 TLP-101 HOUSING 1 

2 HOU01405 TLP-101 Connector Endcap 1 

3 HOU01408 TLP-101 Transducer Endcap 1 

4 HOU01407 TLP-101 Transformer Cradle 1 

5 TDC00057 16-24 KHz Omni Tdcr w/ 3/4-16 Stem 1 

6 EM40PCA Module for TLP-10X Pingers 1 

7 HOU01410 TLP-101 Ring 1 

8 HOU01409 TLP-101 Post 4 

9 BP-RBS-1 Battery Pack RBS-1 1  

10 EMBU100 EMBU-100 PCB Assembly 1 

11 HOU01406 TLP-101 Battery Plate 1 

12 TLP101XF 16-24 kHz XFM 10P 400S 1 

13 HDW00583 HDW-stand off-3/16D 1”L SS #4 TLP 8 

14 HDW00582 HDW-stand off 3/16D 3/4L #4 SS TLP 4 

15 HDW00252 HDW-SS-4-40-1/4“ Button Cap 4 

16 HOU01204 Rotating Switch 1 



17 HOU01226 LED View Port RBS, TLT 1 

18 CON00302 5-PIN-CONN 1 

19 SWT00316 SWITCH-Magnetic (TLT/RBS) 1 

20 HDW00202 HDW-SS-6-32-1/4-BUTTON CAP 5 

21 HDW00174 HDW-SS-6LG-FLAT WASHER 1 

22 LBL00000 LBL-SPORT-TX-Knob 1 

23 ORI00011 O-Ring 2-228 E515 or E540 2 

24 ORI00007 O-Ring 2-020 E515 1 

25 ORI00006 O-Ring 2-014 E515 1 

26 ORI00004 O-Ring 2-012 E515 1 

27 SSP1 Small Smart Pressure Transducer 1 

28 HDW00168 HDW-SS-4-40-3/4-Socket Cap 8 

29 HDW00188 HDW-6-32-3/8-SS-Socket Cap 1 

30 HDW00378 HDW-SS-4-40×1/2”-Flat Cap 4 

TLP-102 Configuration 

31 TDC00006 38 kHz Omni Tdcr w/ 3/4-16 Stem 1 

32 TLP102XF 34-42 kHz XFM 5P 230S 1 
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1. Introduction 
The TLP-103 target locating pinger is a miniature pinger designed primarily for use with the 
RangeNav™ underwater tracking range. It is used in field for tracking small vehicles (AUV, UUV or 
ROV), divers and other underwater targets. The TLP-103 is a self-contained instrument which is 
housed in a cylinder measuring just 40 mm (1.6”) diameter and 135 mm (5.3”) long. It weighs just 
50g in the water. A 9V alkaline battery powers the pinger, which is sufficient for about 8 hours of 
active tracking. The pinger operates in a frequency of 34kHz-42kHz. A magnetic swipe switch 
activates the pinger and a LED indicates instrument status. The TLP-103 is easy to install, just 
mount the small cylinder on some opportune part of the target using hose clamps, cable ties or even 
duct tape. The RangeNav™ surface station will track the position and depth of the target as soon as 
it enters the water. 

The TLP-103 works at depths to 300 meters and RangeNav™ listening stations spaced at 250m will 
in most cases easily pick up the signal. Using the TLP-103 with 500m station spacing is a possibility 
under good conditions, but should be tested at your site first. 

TLP-103 Design Characteristics 

● Target Locating Pinger, for tracking of small vehicles, divers and equipment. 
● Straightforward installation in minutes. 
● Miniature, self-contained, rugged design. 
● Designed for use with 250m listening station spacing, depth to 300 meters. 
● Powered by user replaceable 9V alkaline battery. 
● Supports sub-meter 3D tracking accuracy. 
● Equipped with a 500 PSIA (300m) depth sensor, which has an accuracy of 5 PSI (3m). 
● Selectable frequency channels for support of multiple target tracking. 

Figure 1 shows the TLP-103 Target Locating Pinger. The sonar transducer and the depth sensor are 
integrated into the lower part of the housing. The dual-color status LED is visible through one hole in 
the outer cover, and the other hole designates the location of the power/configuration magnetic 
swipe switch. The top end cap can be removed to access and replace the 9V battery. 



 

Figure 1: TLP-103 Target Locating Pinger 

2. Unpacking 
Please ensure that your shipment does contain these components. TLP-103 Component List 

● TLP-103 Target Locating Pinger 
● Pinger equipment case (yellow box) 
● Power/configuration switch actuation magnet on lanyard 
● This manual is available at www.desertstar.com/downloads 

http://www.desertstar.com/downloads


 

Figure 2: TLP-103 Shipping Configuration 

If a shipment is incomplete, please contact Desert Star Systems. 

In order to operate your TLP-103 you will also need the RangeNav™ system components including 
the STM- 100 surface station junction box, PC, RBS-100 listening stations, RPD cable sections and 
the DiveBase RangeNav™ software for the Windows PC. 

3. Preparations For Operation 
Follow these simple steps to get your target locating transponder ready for operation. 

Preparations For Operation 

● Unpack the pinger and make sure you've got all the parts. 
● Install a 9V alkaline battery. 
● Configure the TLP-103 using the magnet switch with LED feedback. (SKIP this step if you 

don’t need to change the channel number, 1…8) 
● Mount the TLP-103 on the target. 
● Switch the pinger on prior to launching the target. 

3.1 Changing The Internal Batteries 

http://www.desertstar.com/downloads
http://www.desertstar.com/downloads


CAUTION!Installing or changing the TLP-103 battery requires opening the pinger. This will expose the electronics and 

make them vulnerable to damage due to water intrusion, static electricity discharge, contamination, strike etc. Improper 

re-assembly also risks a leak in the housing and consequential flooding, which will lead to almost certain destruction of your 

TLP-103. Always work at a clean, reasonably static free work station when opening the transponder. Pay attention to detail. 

Desert Star Systems cannot accept responsibility for operator error resulting in equipment damage. 

A 9V battery powers the pinger. The brand of the battery does not matter so long as it is Alkaline. 
We use Energizer just because we like musical rabbits. 

 

Figure 3: The Battery Compartment 

To change the battery, follow these instructions. 

● Wipe the TLP-103 dry prior to opening. 
● Remove the spiral ring from the retaining pin, and remove the retaining pin. 
● Open the end-cap by combining a gentle motion of twisting and pulling. Be aware that 

water drops that may have accumulated just outside of the O-ring will get sucked in by a 
temporary relative vacuum. Prevent that by watching the O-ring area through the clear 
housing, wiping away drops and slowly removing the end cap. 

● Turn the lever switch that secures the battery, pull the battery out (you may have to 
thump the open side of the housing against the palm of your hand to encourage the 
battery to move) and replace. Watch the battery polarity. The + contact must match with 
the red post, the – contact with the black post. Reversed insertion will not do any 



damage, but the transponder will not work. Make sure to lock the battery by rotating the 
lever. 

CAUTION:You will notice the configuration connector along the leading edge of the board. It incorporates a brown 

lever that may flip open or possibly break off if disturbed. You should avoid that from happening, but the transponder function 

will not be affected. 

● Clean the O-ring and apply a thin film of silicone grease if dry. Also, inspect the O-ring 
mating surface. 

● Insert the end-cap and secure with the retaining pin and spiral ring. 
● Inspect the O-ring through the clear housing. A proper seal is characterized by an 

unbroken shiny black area (the O-ring compression area). Watch for any contaminants 
and correct if there is a problem. 

3.2 Station Activation and Magnet Switch Operation 

A magnetic switch is used to switch the TLP-103 ON, OFF and. To operate the switch, swipe the 
magnet included with your transponder past the right marking hole in the outer cover. You may have 
to experiment a bit to find the best spot for actuation, but the green LED will light to indicate when 
you ‘made contact’. If you lose the magnet do not worry, any magnet will do. 

 

Figure 4: Operating the Magnetic Switch 

Table 1 lists the various actions that can be initiated with the magnetic switch. 

Action How to initiate Status LED feedback 



Switch 
TLTP-103 ON 

Briefly hold magnet over 
switch 

Green LED lights when switch is actuated. 
Red status blink pattern when magnet is 
removed. 

Switch 
TLP-103 OFF 

Hold magnet over switch 
for 3 to 9 seconds. 

Green LED lights when switch is actuated. 
LED OFF when magnet is removed. 

Configure the 
TLP-103 

Hold magnet over switch 
for 10 or more seconds. 

Green LED lights when switch is actuated. 
Red LED lights when configuration mode is 
activated. 

Enter a 
configuration 
parameter 

When correct amount of 
LED blinks occur, swipe 
magnet. 

See section 3.4 

Table 1: Switch Operation 

3.3 Status LED Blink Patterns 

The TLP-103 uses a two color (red/green) status LED. Here is a guide to the blink patterns. 

Blink 
Pattern 

Interpretation 

RED 
rapid 
blinking 

The battery is low. Replace it. 

RED 
single 
blink 
once per 
second 

The pinger is operating normally. 

RED 
triple 
blink 

Hardware error. This blink patterns currently indicates a depth reading too far 
from zero. Causes could be a defective depth sensor, or you switched the 
transponder ON while submerged. Transponder functions will still work, although 
the depth reporting may be faulty. 



GREEN 
LED 
lights 
solid 

Magnet switch actuation has been detected 

RED and 
GREEN 
LED light 
solid 

When holding the magnet switch for 10+ seconds next to the switch, this pattern 
indicates that the configuration mode has been enabled. 

RED one 
to eight 
blinks. 

In configuration mode, indicates a current Channel setting. See section 3.4. 

Table 2: Status LED Blink Patterns 

3.4 Configuring The TLP-103 

The TLP-103 is configured through the use of the combined power/configuration magnet switch. Use 
the lanyard with the magnet embedded in the yellow pouch to operate the switch. The only thing that 
you would actually be configuring is the channel definition. If you are tracking a single target this step 
is not needed. 

1. To initiate transponder configuration, hold the magnet over the switch for up to ten 
seconds. The green LED will light as soon as the switch is triggered. Keep holding the 
magnet until the red LED lights solidly (not blinking), indicating that transponder 
configuration has been initiated. Now, remove the magnet. 

2. Transponder Channel setting: The TLP-103 can be set to one of eight Channels, 1…8. 
This allows simultaneous tracking of up to eight TLP-103 pingers. If you are using a 
single pinger, always use channel #1. If you are tracking multiple transponders, assign 
each a unique Channel number. For best operating convenience (and least confusion), 
assign a solid block of Channels starting at #1. The TLP-103 will blink the red LED in an 
endless pattern sequence of one to eight blinks, with the number of blinks corresponding 
to the Channel code. Select a Channel code by triggering the switch in the pause after 
that Channel code has been transmitted as a blink pattern. The lighting of the green LED 
confirms your selection. 

4. Pinger Mounting 



The sonar transducer of the TLP-103 is the antenna of the system. The transducer is integrated into 
the bottom of the housing, in the area of the white label. Proper placement and mounting of the 
transducer is required for good tracking. 

Mount the TLP-103 so that the sonar transducer remains un-obscured, or shielding by any nearby 
hardware or the acoustic shadow of the diver’s body (for tracking) is minimized. The TLP-103 should 
also be mounted vertically, typically with the sonar transducer facing away from the surface the 
pinger is mounted on. This is recommended to align the doughnut shaped beam pattern of the 
transducer with the horizontal plane. Of course, at times vertical mounting may not be practical and 
so the recommendation is to come as close to that ideal as possible. The system will in general still 
work, but effective distance from the listening stations may be reduced, or listening stations in one 
particular direction may not be able to pick up the signal. 

For small vehicles, the best performing mounting areas are generally the bottom or the top of the 
vehicle. For diver mounting, consider floating the TLP-103 above the diver (use a small float) or 
dropping it below the diver (consider attaching some weight). You can also attach the TLP-103 
directly to the diver’s tank or possibly even place it in a b/c pocket. However, due to the resulting 
signal shielding, the effective tracking range will probably be less (similar to the result of having your 
cell phone antenna in a poor location or inside a shielded building). As shown in the figure below, the 
pinger was attached to the diver’s tank and we still tracked fine; although range may have been 
reduced. 

Guidelines For TLP-103 Mounting on a Small Vehicle 

● The sonar transducer, which is located in the bottom of the housing around the area of 
the white identification label, should not be shielded by any part of the vehicle. It is 
preferred to mount the TLP- 103 near the top of the vehicle, vertical with the transducer 
facing up, or the bottom with the transducer facing down. This affords a near 
unobstructed view of the seafloor mounted listening stations. 

● Keep the pinger away from the thrusters as these may produce some disturbances that 
could shield the pinger’s signal. 

● Maximize the space between the TLP-103 sonar transducer and other sonar transducers 
on the vehicle. While the TLP-103 will not receive or be disturbed by any interference, its 
signals may interfere with other acoustic systems. If using scanning or imaging sonar, 
mount the TLP-103 out of the beam pattern of that instrument. 

● For best performance, mount the TLP-103 vertically, with the transducer facing away 
from the vehicle. 

● Use a bracket or another rigid structure to secure the pinger. Use the area between the 
sonar transducer and the status LED and magnetic switch to mount securing hardware 
(this area does not require access). 



 

Figure 5: Mounted TLP-103 on Diver 

Though the TLP-103 is NOT mounted vertically, AND is clearly obscured by the diver’s sonar shadow, we still tracked this 

diver over the shorter test distances. 

5. TLP-103 Maintenance 
Your TLP-103 is a rugged instrument that requires very little maintenance. However, please do 
observe the following points to ensure long and proper operation. 

Maintenance Instructions 

● Rinse the pinger with fresh water after each deployment. 
● Remove the battery if the pinger will not be used for a significant amount of time. 
● The TLP-103 chassis is sealed by a single O-ring; keep the O-ring clean and lubricate 

with a thin film of silicone grease if dry. Inspect for any cuts or abrasion, and replace the 
O-ring if damaged. 

● Keep the small depth sensor hole in the bottom label free of debris. Rinse with a water 
stream if obstructed. DO NOT penetrate with a sharp object to clean. This tiny sensor 
uses a very soft gel membrane which is very easily damaged by mechanical attack. 

6. TLP-103 Specifications 

Size: 135 mm L x 40 mm D (5.3” L x 1.6” D) 

Weight: 230g in air 



50g in water 

Depth Rating: 300 meters max. working depth 

Operating 
temperature: 

0-50 degrees Celsius 

Configuration & 
control: 

Magnet swipe switch 

Status Indicator: Dual color RED/GREEN status LED 

Sensors: Depth sensor for depths of 0-300 meters, calibrated to within 0.7 m in 
the range from 0m to 70m 

Sonar 
Transmitter: 

Frequency hopping, operating at 33.8 kHz to 42 kHz 

Source Level >= 177dB re. 1 μPa 

Sonar 
Transducer: 

Near omni directional transducer (hollow cylinder) integrated in 
housing. 

Power supply: Powered by single 9V alkaline battery. Battery life (approximately): 

Tracking mode with one transmission per second: 8 hours 

Note: all specifications are subject to change without notice 

ITEM NO. PartNo DESCRIPTION QTY. 

1 HOU01101 Scout TX Housing 1 

2 BRB-1 BOTTOM BOARD,TLT-REV.B 1 

4 TDC00036 38kHz Omni Ceramic Element,12“ lead 1 



5 HOU01444 TLT-2 TRANSFORMER SUPPORT 1 

6 TRB-1 TLT-1 REv. B, TOP ROUND BOARD 1 

7 BAT00327 9V BATTERY FOR SPORT RX 1 

8 HOU01445 TLT-2 Battery Cradle 1 

9 HOU01446 TLT-2 Battery Secure 1 

13 EM-41 TLT-Rev.B Main Board 1 

15 XFM00319 FT-114-67 Toroidal Core Ferrite 1 

16 HOU01443 TLT-2 ENDCAP 1 

17 HDW00281 HDW-Clevis Pin-New Scout TX 1 

19 ORI00015 O-Ring 2-122 E515 New Scout 1 

20 HDW00282 HDW-SPLIT RING 0.430” FOR NEW SCOUTS 1 

21 HDW00362 HDW-SS-2-56 1/2 SOCKET CAP 4 

22 SSS00059 Scout Tx Bottom label & Micro TLT 1 



 

 


